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Introduction 9

1 Introduction

Strum Acoustic GS-1 is a synthesizer dedicated to the emulation of acoustic guitars. The syn-
thesizer is entirely based on the A|A|S physical modeling technology and uses no sampling nor
wave tables. Instead it produces sound by solving, on the fly, mathematical equations modeling the
different components of a guitar and how they interact. This elaborate synthesis engine responds
dynamically to the control signals it receives while you play thereby reproducing the richness and
responsiveness of real instruments.

Strum Acoustic features elaborate modeling of the vibrations of the strings, pick or finger action
and the body of the guitar. Strum Acoustic also includes many functionalities which make it easy
to reproduce the playing techniques of a guitarist on a keyboard. Strum Acoustic includes a chord
detection module and performs automatic voicing of chords. In other words, you play the chords
you know on the keyboard and Strum will voice them automatically, for different musical styles, as
a guitarist would have played them. The picking-hand technique of a guitarist is reproduced by an
auto-strum function, special strumming keys or using standard MIDI loops.

Before discussing the synthesizer in more detail, we would like to take this opportunity to thank
you for choosing an A|A|S product. We sincerely hope that this product will bring you inspiration,
pleasure and fulfill your creative needs.

1.1 System Requirements

The following computer configuration is necessary to run Strum Acoustic:

Mac OS :

• Mac OSX 10.2 (Jaguar) or later.
• G4 733 MHz Processor
• 256 MB RAM
• 1024 x 768 or higher screen resolution
• MIDI Keyboard (recommended)
• Ethernet Port

Windows :

• Windows 98SE/ME/2000/XP
• PIII 800 MHz
• 128 MB RAM
• 1024 x 768 or higher screen resolution
• DirectX or ASIO supported sound card
• MIDI Keyboard (recommended)
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Keep in mind that the computational power required by Strum Acoustic depends on the number
of voices of polyphony and the sampling rate used. These computer configurations will enable you
to play the factory presets with a reasonable number of voices.

1.2 Installation

Mac OS

Insert the Strum Acoustic program disc into your CD-ROM drive. Open the CD icon once it
appears on your desktop. Click on the Strum Acoustic Install icon and follow the instructions of
the installer.

If you purchased this software online, simply double-click on the installer file that you have
downloaded and follow the instructions of the installer.

Windows

Insert the Strum Acoustic program disc into your CD-ROM drive. Launch Explorer to view the
content of the CD-ROM and double-click on the installer file to launch the installer.

If you purchased this software online, simply double-click on the installer file that you have
downloaded and follow the instructions of the installer.

1.3 Authorization and Registration

Strum Acoustic uses a proprietary challenge/response copy protection system which requires au-
thorization of the product. A challenge key is a long string of capital letters and numbers that
is generated uniquely for each machine during the registration process. In other words, for each
machine you install this program on, a different challenge key will be generated by the program.
The response key is another unique string of capital letters and numbers generated from the data
encrypted in the challenge key. In order to obtain a response key, you will need to connect to the
A|A|S website and provide the following information:

• A valid email address

• Your product serial number (on the back of the sleeve of your CD or in your confirmation
email for downloads)

• The challenge key generated by the program

Note that it is possible to use the program during 15 days before completing the authorization
process. This period can be convenient if you are installing the program on a computer which is
not connected to the internet. After that period, the program will not function unless it is supplied
with a response key.

In the following sections we review the different steps required to generate the challenge keys
and obtain the response key. The procedure is similar on Windows XP and Mac OS systems.
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1.3.1 Step 1: Generating the Challenge Key

After launching the installer for the first time, a pop-up window will appear asking you if you wish
to authorize your product now or later. If you are ready to authorize Strum Acoustic now, click on
the Next button otherwise click on the Authorize Later button. If your computer is connected to
the internet, we recommend that you authorize your product now.

Figure 1: Choosing to authorize Strum Acoustic now or later.

When you click on the Next button, a second window appears asking you to enter your serial
number. Type your serial number as it appears on the back of the sleeve of the Strum Acoustic
CD-ROM. If you purchased Strum Acoustic online, an email with your serial number will have
been sent to you at the address which you provided during the purchase process.

After entering your serial number, click on the Next button and your challenge key will appear
automatically in the next pop-up window.

1.3.2 Step 2: Generating the Response Key and Registering your Product

If your computer is connected to the internet, click on the link to the A|A|S web server appearing
in the pop-up window. This will launch your web browser and connect you to the unlock page of
the A|A|S web server. Enter your email address, serial number and challenge key in the form as
shown below and click on the Submit button.

The next form asks you to provide additional information about yourself including your mailing
address and phone number. This information will be used to register your product. Note that
only a valid email address is required to register your product. We nevertheless recommend this
information be provided to ensure our support team is able to contact you to resolve any future
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Figure 2: Enter your serial number in the pop-up window.

Figure 3: The challenge key appears automatically after entering the serial number.

support issues, and notify you of product updates promptly. This information is kept completely
confidential. Registration of your product will entitle you to receive support and download updates
when available, as well as take advantage of special upgrade prices offered from time to time to
registered A|A|S users. Note that if you already purchased or registered another A|A|S product, the
information that you have already supplied under the same email address will appear in the form.
Feel free to update this information if it is outdated. Click on the Submit button and your response
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Figure 4: Enter your registration information on the A|A|S webserver.

key will appear on-screen.

Figure 5: Generation of the response key on the A|A|S server.

If your computer is not connected to the internet, take note of your serial number and challenge
key and proceed to an internet connected computer. Launch your browser and go to the unlock
page of the A|A|S website at:

http://www.applied-acoustics.com/unlock.htm

Enter your email address, serial number, and challenge key, and click next. You will then
receive your response code on-screen as described above.

http://www.applied-acoustics.com/unlock.htm
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1.3.3 Step 3: Completing the Unlock Process

The response key corresponding to your serial number and challenge key will be printed in your
browser window. In order to complete the unlock process, copy the response key and paste it into
the corresponding field of the installer window of Strum Acoustic. If you obtained your response
key from another computer, type the response key by hand in the installer window.

Figure 6: Final step of the unlock process. Enter your response key in the window.

Click on the Next button and a pop-up window will appear informing you that the authorization
process has been successful. Click on the Finish button to complete the process and launch Strum
Acoustic.

You will normally only need to go this process once for a given computer except for some
special cases. On Windows computers your will need to unlock again if:

• You change your computer

• You reformat or upgrade your hard drive

• You change or upgrade your operating system

On Mac OS computers, this will only be necessary if:

• You change your computer

• You change the motherboard of the computer
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Figure 7: Authorization has been successful.

1.3.4 Obtaining your Response Key and Registering by Fax or over the Phone:

Should you not have access to the internet, A|A|S support representatives are available to assist
you in the unlock and registration process Monday to Friday, 9am to 6pm EST. You may contact
us by phone at:

• North America Toll-free number: 1-888-441-8277

• Outside North America: 1-514-871-8100

• Fax Number: 1-514-845-1875

• Email: support@applied-acoustics.com

1.4 Getting Started

1.4.1 Using Strum Acoustic in Standalone Mode

The Strum Acoustic comes with a wide range of factory presets right out of the box which amounts
to a huge range of sounds before you have even turned a single knob. As you would expect, the
best way of coming to grips with the possibilities Strum Acoustic offers is simply to go through the
presets one at a time. We recommend that you first start using Strum Acoustic in standalone mode.

• Windows - Double-click on the Strum Acoustic icon located on your desktop or select Strum
Acoustic from the Start > All Programs > menu.
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• Mac OS - Double-click on the Strum Acoustic icon located in the Applications folder.

Before you start exploring the factory presets, take a moment to set up you audio and MIDI
configuration as explained below.

Audio Configuration

Audio configuration tools are available from the Audio menu. The Audio Settings function allows
you to select an audio output device from a list, organized by driver type, of those available on your
computer. On Windows, if you have ASIO drivers available, these should be selected for optimum
performance. Multi-channel interfaces will have their outputs listed as stereo pairs.

• Select your sound card port from the list in the Audio Configuration dialog from the Audio
> Audio Settings . . . menu.

For more detailed information on audio configuration, sampling rate selection and latency ad-
justments, please refer to section 8.3.

MIDI Configuration

MIDI configuration tools are available from the MIDI menu.

• Select your MIDI input device from the list in the MIDI Configuration window available
from the MIDI > MIDI Settings . . . menu.

For more detailed information on Audio and MIDI configuration, MIDI links and MIDI maps,
please refer to Chapter 8.

1.4.2 Exploring the Factory Presets

Factory presets can easily be accessed using the ‘+” and ‘−” buttons in the lower left corner of the
toolbar. These buttons are used to navigate through a list of 128 numbered presets called programs.
The content of this program list can be viewed by clicking on the H button of the toolbar. The
number of the current program used and the name of the associated preset appear on the right of
this button. Programs can also be changed by using the ‘+” and ‘−” keys from the computer
keyboard or by selecting programs directly from the list displayed after clicking clicking on the H
button.

Presets can also be accessed using the browser appearing on the left of Strum Acoustic. This
browser is similar to the browser your operating system generates to display the contents of your
hard disk, or your email program uses to organize your mail and address book. When launching the
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application for the first time, this “tree view” will include a destination folder for imported presets
as well as a Presets folder. To open a folder, click on the “+” symbol on Windows or I symbol
on Mac OS which will reveal the folder content.

The preset library is different from the program list and can be viewed as a repository con-
taining all the presets available to the application. Presets are loaded into the synthesis engine by
copying them from the library into the program list. To load a preset, double-click on a preset icon
(blue knob) or preset name. This will insert the preset into the program list at the position of the
current program. You can also use the arrow keys on the computer keyboard in order to navigate
in the preset list and then the Enter key to load a preset. For additional information on presets and
programs, please refer to Chapter 5 of this manual.

1.4.3 Using MIDI Links

Every parameter on the Strum Acoustic interface can be linked to an external MIDI controller. To
assign a MIDI Link, right-click (control-click on Mac) on a control (knob, button or slider) and a
contextual menu will appear. Select Learn MIDI Link and move a knob or slider on your MIDI
controller to activate the link. To deactivate the link, right-click (control-click on Mac) on the
control and choose the Forget MIDI Link command. Refer to section 8.2 for more details on
MIDI links.

1.4.4 Using MIDI Program Changes

The synthesizer responds to MIDI program changes. When a program change is received, the
current program is changed to the program having the same number as that of the program change
message received by the application.

1.4.5 Using Strum Acoustic as a Plug-in

Strum Acoustic integrates seamlessly into the industry’s most popular multi-track recording and
sequencing environments as a virtual instrument plug-in. Strum Acoustic works as any other plug-
in in these environments so we recommend that you refer to your sequencer documentation in case
you have problems running Strum Acoustic as a plug-in.

1.5 Getting Help

A|A|S technical support representatives are on hand from Monday to Friday, 9am to 6pm EST.
Whether you have a question on Strum Acoustic, or need a hand getting it up and running as a
plug-in in your favorite sequencer, we are here to help. Contact us by phone, fax, or email at:

• North America Toll Free: 1-888-441-8277
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• Worldwide: 1-514-871-8100

• Fax: 1-514-845-1875

• Email: support@applied-acoustics.com

Our online support pages contain downloads of the most recent product updates, and answers
to frequently asked questions on all A|A|S products. The support pages are located at:

www.applied-acoustics.com/support.php

1.6 Forum and User Library

The A|A|S community site contains the Strum Acoustic user forum, a place to meet other users
and get answers to your questions. The community site also contains an exchange area where you
will find presets for your A|A|S products created by other users and where you can make your own
creations available to other users.

http://community.applied-acoustics.com/php/community/

http://community.applied-acoustics.com/php/forum/

1.7 About this Manual

In the next chapter, the general functioning of Strum Acoustic is presented. Chapter 3 describes
the special keyboard layout used to play Strum Acoustic. Playing techniques are then presented in
chapter 4. Chapter 5 explains how to use the application browser and how presets and MIDI maps
are managed. In Chapter 6, the different modules and controls are reviewed in detail. Chapter 7
describes the different functionalities available from the toolbar while Chapter 8 explains the dif-
ferent functionalities related to Audio and MIDI and their settings. General issues involved in the
use of Strum Acoustic as a plug-in in different host sequencers is covered in Chapter 9. Finally a
list of available commands and shortcuts is given in Chapter 10.

Throughout this manual, the following conventions are used:

• Bold characters are used to name modules, commands and menu names.

• Italic characters are used to name controls on the interface.

• Windows and Mac OS keyboard shortcuts are written as Windows shortcut/Mac OS shortcut.

http://www.applied-acoustics.com/support.php
http://community.applied-acoustics.com/php/community/
http://community.applied-acoustics.com/php/forum/
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2 An Overview of Strum Acoustic

Strum Acoustic is a synthesizer which was designed with the goal of enabling keyboard players to
easily create realistic guitar tracks. This is a task which is usually difficult to achieve due to the
very different nature of these two types of instruments. Strum was therefore designed to reproduce
not only the sounding mechanism of a guitar but also the main elements of the playing technique
of a guitar player.

Very generally playing on a guitar can be described in terms of fretting hand (usually left hand)
and picking hand (usually right hand) techniques. The fretting hand is used to fix the chords or
notes played on the different strings of the guitar while the picking hand is used to set the different
strings into vibration and therefore play melodies or strumming patterns. In Strum, these functions
have been integrated into a chord detection, voicing, and strumming module.

2.1 Chord Detection and Voicing

Chords played on a keyboard and a guitar share the same name but are played or voiced differently.
Because of the tuning of the strings on a guitar, the notes of the chord are not usually played
in the same order as on a keyboard and the range of the notes is usually different, notes may
also be repeated. Furthermore, the same chords can be played in different positions on the guitar
depending on the playing or musical style. This specific way of playing chords on a guitar is very
characteristic of the tone and sound of the instrument. It is therefore very important, in order to
obtain a realistic guitar sound, to play chords as a guitar player would rather than how they are
played on the keyboard.

The voicing of chords for the guitar is performed in two steps by Strum. A chord played on the
keyboard is first interpreted by the chord detection module in order to determine which chord was
played on the keyboard. Strum then finds a guitar voicing corresponding to this chord. In other
words, Strum finds how a guitar player would have played this particular chord.

When chords are played on the keyboard, the order of the notes above the root is not taken
into account by the chord detection engine. This implies that you can play the chords as you know
them on the keyboard without having to know or learn special voicings used by guitar players. For
example, you could play chords in close position with the left or right hand, you could also play
the root with the left hand and the rest of the chord with the right hand or play the chords with
the notes spread across both hands. Strum will take care of finding the right voicing and playing
position on the guitar depending on the settings of the chord type and playing position controls as
described in section 4.6

The name of the chord detected as well as the specific voicing chosen by Strum is displayed in
the fretboard located in the lower portion of the graphical interface. Note that the voicing chosen by
Strum varies depending on the chord type chosen by the user as is described in Section 4.6. Strum
will try to detect a chord as soon as three or more keys are depressed on the keyboard. Otherwise
Strum will assume that a melody or interval is played. Please refer to section 11 for a list of the
chords detected by Strum.
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2.2 Strumming

On a guitar, notes and chords are triggered by the action of the picking hand (usually right hand).
The resulting sound is very typical of a guitar as the guitarist triggers the strings sequentially, more
or less rapidly, with an up and down motion of the hand. Strings can also be played individually,
in different order, to create arpeggio patterns. Different sonorities can be obtained by damping
or muting the strings either by applying the picking hand on the strings near the bridge (palm
muting) or releasing the pressure on the notes played with the fretting hand (scratching) while
strumming. Using these different types of hand motions and techniques, the guitarist can create
complex melodic and rhythmic patterns. In Strum, these different effects can be achieved through
a strumming module which is controlled by special strumming keys or MIDI loops as will be
explained in more details in Chapter 3, 4 and 6.

2.3 The Graphical Interface

The graphical interface of the instrument is divided in three sections. From top to bottom on the
interface one first finds the output effect section which is used to shape the final sound of the
instrument. This effect section includes and equalizer a multi-effect module with sync capabilities
and a reverb.

The middle guitar-shaped section of the interface is where all the parameters controlling the
synthesis engine are located. The different control parameters refer to the strings, the pick and its
interaction with the strings, the action of fingers on the fretboard and the body of the guitar. This
section has seven different views. The main and simplest one (All)is used to display parameters
acting on the six strings of the guitar while the other six views reveal parameters for the individual
strings.

The bottom part of the interface is centered around a fretboard where the chords detected and
the specific voicings chosen by Strum are displayed. This section of the interface also includes
parameters determining how the voicing and strumming is performed by Strum, a MIDI loop player,
tuning parameters and controls determining how signals from some standard MIDI controllers are
interpreted by Strum.

2.4 Signal Flow

The general signal flow of Strum is presented in Figure 9 and illustrates schematically how the dif-
ferent modules in Strum interact. From left to right, the synthesizer first includes a chord detection
module which parses the MIDI signal it receives and determines the chords played on the keyboard.
This information is then sent to the voicing engine which, taking into account how a guitarist would
actually play the different chords, determines which notes are played on the different strings of the
guitar. The corresponding information, for each of the six strings of the instrument, is then sent to
a triggering or strumming module which generates an excitation signal for each of the individual
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Figure 8: Control modules and output stage of String Studio (Panel A).

string. This is the signal received by the synthesis or string module which then simulates the vi-
bration signal of the individual strings of the guitar. The output of this module corresponds to the
signal that would actually be measured at the bridge of the instrument and which is transmitted to
the body of the instrument. The body module completes the instruments and simulates how sound
is radiated both from the top-plate of the body (or soundboard) and the air cavity of the body. Fi-
nally, in addition to the modules reproducing the guitar itself, an output stage has been included to
allow further processing of the sound radiated by the instrument.

It is important to note how the MIDI signal received by the synthesizer is parsed. Signal
received from the MIDI input or MIDI player module, is interpreted in terms of the fretting hand
(usually left hand) and picking hand (usually right hand) of a guitar player. MIDI notes with
number ranging between 40 (E1) and 70 (B[4) are associated with the fretting hand and their
corresponding signal is sent to the chord detector. Notes with number ranging between 71 (B4)
and 84 (C6) are special strumming keys, used to trigger different picking hand techniques, and are
therefore used to control the strumming engine. The use of these strumming keys is explained in
more details in section 3.
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Figure 9: General architecture of Strum.
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3 Keyboard Layout

Strum reacts to MIDI signal differently than a traditional synthesizer. It uses a special keyboard
layout and associates signals from standard MIDI controllers with specific effects or techniques on
the guitar. In this chapter, we will describe how the keyboard is used to play Strum.

The MIDI signal received by Strum is interpreted in terms of the fretting hand (usually left
hand) and picking hand (usually right hand) of a guitar player. The range of the MIDI keyboard
has therefore been divided into two sections, the Lead & Chord keys section and the Strumming
Keys section as illustrated in Figure 10.

3.1 Lead and Chord Keys

This section is associated with the fretting hand of the guitarist and includes notes ranging from
MIDI note numbers 40 (E1) to 70 (B[4). This section of the keyboard is where melodies and
chords are played and it is the MIDI signal from this section which is sent to the chord detection
and voicing modules. Strum will try to detect a chord and find a corresponding voicing as soon as
three keys or more are depressed on the keyboard, otherwise it will play the notes as a melody or
an interval.

3.2 Strumming Keys

Notes with MIDI number ranging between 71 (B4) and 84 (C6) are interpreted as special strum-
ming keys and are used to trigger different picking hand techniques as shown in Figure 10. De-
pending on the strumming keys used one can trigger downstrokes, upstrokes as well as palm muted
or muffled downstrokes and upstrokes. Strings can also be triggered individually to play arpeggio
patterns. The effect of the different strumming keys is now reviewed.

3.2.1 Downstroke and Upstroke

A downstroke is achieved by dragging a pick (or the fingers) across the strings of the guitar in a
downward motion. Notes are therefore played from lowest to highest. An upstroke is obtained in
the same manner but dragging the pick or fingers upwards from the highest to the lowest string.
A downstroke is triggered by depressing MIDI note 72(C5) while an upstroke is triggered by de-
pressing MIDI note 74 (D5). These strokes represent the simplest way to play chords on a guitar
and can be played alternately. Note that when strings are not used in a specific voicing (strings
marked with an X in the chord display of the graphical interface), they are not played when using
a downstroke or an upstroke.
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3.2.2 Palm Muted Downstroke and Upstroke

Palm muting is a technique which consists in partially muting the strings with the help of the
picking hand by letting it lightly touch the strings near the bridge. The pick (or fingers) is then
dragged across the strings in a downward or upward motion. In Strum, the palm muted downstroke
and upstroke are obtained by depressing MIDI note number 73 (C#5) and 75 (D#5) respectively.

3.2.3 Muffled Downstroke and Upstroke

A muffled stroke (or scratch) is obtained by laying the fretting hand on the strings without depress-
ing them and then striking the strings with the picking hand. This produces a percussive sound and
the guitar player can control the effect by applying more or less pressure on the strings. In Strum,
the muffled downstroke and upstroke are obtained by depressing MIDI note number 78 (F#5) and
80 (G#5) respectively.

3.2.4 Mute All

A muted strum is a stroke which is immediately muted by applying the full hand on all the strings
in order to completely stop the sound. In Strum, this is effect is reproduced by depressing the MIDI
note number 82 (B[5).

3.2.5 Alternate Strum

It is common for guitar players to vary the number of strings which are strummed when playing
rhythmic patterns on a chord. In Strum it is possible to define a main and an alternate strum using
the strumming range control as explained in section 6.7.4. The MIDI note 71(B4) is used to switch
between these two types of strum. When this key is depressed while another strumming key is
used, the alternate strum is played. The main strum range is used when it is released. This rule
applies to the standard up and down strums but also to the palm muted and muffled strokes. The
alternate strum can also be triggered with the hold pedal when the Alt. Strum button is switched on
as explained in section 6.7.8

3.2.6 Playing Individual Strings

The strings of the guitar can be played individually enabling one to arpeggiate or create finger
picking patterns. Individual strings are triggered by depressing MIDI notes 76(E5), 77(F5), 79(G5),
81(A5), 83(B5) or 84(C6). These special strumming keys are labeled bass, alternate bass, arp 4,
arp 3, arp 2 and arp 1 respectively. Notes in the chords are triggered by these MIDI notes from
lowest to highest using the following rules:

• MIDI note 76(E5): Bass. always the lowest note in the chord played by Strum.
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• MIDI note 77(F5): Alternate bass. When the chord played by Strum is not inverted and
the chord includes a fifth (natural, lowered or raised) then the alternate bass is the fifth. If
the bass is played on the lowest string (sixth string), then the alternate bass will be played
on the fifth string if possible except in the case of the open G chord where it is played on the
fourth. If the bass is not played on the lowest string (played on the fifth or fourth string), the
alternate bass will then be played on the fifth or sixth string. Finally, if the chord is inverted,
or if it does not include a fifth, the alternate bass trigger will play the same note as the bass.

• MIDI note 79(G5), 81(A5), 83(B5) or 84(C6): Arp key 4, 3, 2 and 1. The remaining notes
in the chord are played from lowest to highest note on arp keys 4 to 1 respectively. If there
are fewer than four notes remaining to be played in the chord, the highest one is repeated on
the remaining arp keys. Finally, if the alternate bass is the fifth and if it can only played on
the string on which it is played in the chord, it is triggered by the alternate bass arp key and
it is not repeated on another arp key.

These rules imply that the arp keys 6 to 1 do not necessarily correspond to string 6 to 1 (lowest
to highest). In fact they only do when the six strings are used in a chord and when the bass is played
on string 6. This is true for example with bar chords played using the six strings. To illustrate these
rules lets consider different chords played in movable position. A G major chord with bass played
on G2 on the keyboard will be voiced by Strum with the bass on the sixth string. The arp key will
then follow the order of the guitar strings. Playing a C major chord with the bass played on C3 on
the keyboard results in a chord voiced by Strum with the bass on string 5 and the alternate bass on
the sixth string. The bass and alternate bass arp keys will therefore trigger the fifth and sixth string
respectively. The remaining arp 4,3,2,1 keys will trigger the fourth, third, second and first strings
respectively. Finally, playing a G Major chord one octave higher than previously (bass on G3 on
the keyboard) results in a chord played by Strum on the four highest strings of the guitar (strings
4,3,2,1). In this case, the bass arp key will trigger the fourth string, the alternate bass will be played
on the fifth string and the remaining three notes of the chord (strings 3, 2 and 1) will be triggered
by arp keys 4, 3 and 2 respectively. The first string will also be triggered by arp key 1.

3.3 Pitch Bend Wheel

The pitch bend wheel produces a slide or a bend depending of the settings of the Pitch Wheel
section of the interface. The Range parameter is used to determine the number of semi-tones in the
slide or bend.

In slide mode, all the strings played in a chord are slided. It is not possible to play lower than
the lowest note of a string when sliding downward. In this case, the slide range will be limited.

In bend mode, only one string is bended at a time. If a chord was just strummed, the highest
note of the chord is bended. If an individual note was just played, this note is bended.
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3.4 Aftertouch

In Strum, bending can be controlled using monophonic aftertouch (also known as channel pressure
on certain controllers). The pitch of the note can be increased in this way by up to one tone
depending on the settings of the Bend control of the Aftertouch section of the interface. If a chord
was just strummed, the highest note of the chord is bended. If an individual note was just played,
this note is bended.

3.5 Modulation Wheel

The modulation wheel is used to control vibrato.

3.6 Hold Pedal

The hold pedal (MIDI CC 64) can be used either as a hold pedal or to activate alternate strumming
depending on the settings of the Hold Pedal section of the interface.

In Hold Chord mode, the pedal will hold the chord played by Strum as long as the pedal is not
released. If a new chord is detected while the pedal is still depressed, the new chord will be played.
The pedal therefore enables one to do instantaneous chord changes.

In Alt. Strum mode, the pedal acts exactly as the first strumming key, MIDI note 71(B4),
described above. As long as the pedal is depressed, all the strumming keys will used the range of
the alternate strum when triggering strings. When the pedal is released the main strum range is
used.
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Figure 10: Sections of the MIDI keyboard as used by Strum.
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4 Playing Strum

Strum can be played in different ways, directly from a MIDI keyboard or using MIDI loops. In this
section we describe these different approaches an how to reproduce specific techniques used by
guitar players. We conclude this section by describing the different voicing options used by Strum.

4.1 Auto-Strum Mode and Strumming Keys

Notes and chords are triggered as they are played on the keyboard when the Auto-Strum mode is
selected. This mode is switched on or off by clicking on the Auto button in the Strumming section
of the interface. In Auto-Strum mode, the notes forming the chord are played using a downstroke
or in other words, notes are played from lowest to highest.

When the Auto-Strum mode is switched off, notes and chords are processed by the chord detec-
tion and voicing modules but the strings are not triggered. In order to play them, one must use the
different strumming keys as described in section 3.2. As soon as a strumming key is depressed, the
strings are triggered. Using strumming keys involves thinking like a guitarist and use the left hand
to play chords or melodies while using the right hand to control the triggering of strings. Note that
strumming keys are always active whether the Auto-Stum mode is switched on or off. In the case
where the Auto-Strum mode is switched on and chords are played simultaneously with strumming
keys, the strumming keys override the normal behavior of the Auto-Strum mode.

4.2 Playing with Auto-Strum

For the first examples, it is necessary to put Strum in Auto-Strum mode by clicking on the Auto
button located in the Strumming section of the the lower part of the interface.

4.2.1 Strum Down

Play a chord in the chord & lead section of the keyboard as shown in Figure 11. The chord
is detected by Strum and voiced on the guitar fretboard. This triggers a downstroke from the
strumming module and consequently the strings are played from the lowest to the highest. In order
to trigger a new downstroke without muting the strings, just release one note from the chord and
play it again as shown in Figure 12.
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Figure 11: A simple strumming sequence.
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4.2.2 Chord Change  
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Figure 12: Re-triggering a downstroke.

Once a chord has been played, the chord detection, voicing and strumming modules are only
triggered when a new note is played; releasing notes from a chord has no effect. Consequently,
Strum holds the current chord as long as all its notes are not released. This can be used to make
rapid chord changes. For example, it is possible to switch from a C chord to a G chord without
muting the strings by playing C-E-G and then by replacing C and E by B and D without releasing
the G as shown in Figure 13. The same effect can be obtained with chords which do not share
common notes by using the hold pedal in Hold Chord mode.
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Figure 13: Smooth chord transition.

On the other hand, if one wishes to remove a note from a chord, for example to switch from a
C7 chord (C-E-G-B[) to a C chord (C-E-G), it is not sufficient to release the B[ key. It is necessary,
in order to trigger again the chord detection module, not only to release the B[ from the chord but
also to release another note from the chord, for example the G, and replay it when one wants to
strum the new chord.

4.2.3 Chords and Change of Pitch

Playing chords on higher or lower notes on the keyboard has a similar effect on Strum’s fretboard.
With so-called Lowest chord types (Open-Lowest, Movable-Lowest and Drop-Lowest) Strum will
make sure that the lowest note played on the keyboard is also the lowest one played in the guitar
chord. These chord types are useful when it is necessary that a succession of chords follows a
certain bass motion.

With the so-called Root chords (Open-Root, Movable-Root), chords detected as inverted are
played on the root note located below the lowest note played on the keyboard (if possible).
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4.2.4 Hammer-On and Pull-Off

Hammer-on and pull-off are playing techniques used by guitar players to play legato or grace notes.
The hammer-on effect is obtained by first picking a note and then hammering down another finger
onto the same string at a higher fret. The pull-off effect is almost the opposite of the hammer on.
It is obtained by first picking a note and then sharply pulling-off the finger from the fretboard in
order to hear a second fretted note on the same string. The sounds produced using these techniques
are softer and less percussive than the ones produced by picking the notes.

With Strum, hammer-ons and pull-offs are automatically triggered by playing legato notes
spaced by one or two semi-tones. They are triggered only when melodies are played and never
when chords are detected.

4.3 Using the Strumming Keys

We now look at ways to create more elaborate effects. For these examples, it is assumed that the
Auto-Strum mode is switch off as we will now be using the strumming keys. This way of playing
Strum involves to think more in terms of a guitar player. Indeed, as the chord recognition and
voicing module require some time to voice the chords, it is necessary to play the chords slightly
before triggering the strumming action with the strumming keys. This is just like a guitar player
who needs to position the fretting hand on the fretboard before strumming with the picking hand.

4.3.1 Down- and Upstroke Strum

Once a chord is played on the keyboard, the downstroke strumming key (C5) is used to trigger a
strum from the lowest to highest string. The upstroke strumming key (D5) is used to trigger strums
from the highest to the lowest string of the guitar. The number of strings which are strummed is
determined by the main strum parameter which appears below the fretboard in the lower part of the
interface. The strumming speed can be controlled using the Speed parameter or the Velocity control
which is used to adjust the amount of modulation from the MIDI velocity signal received from the
keyboard.
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Figure 14: Downstroke and upstroke with the strumming keys.
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In the case where only one or two notes are played on the keyboard, the notes can be triggered
from both the downstroke or upstroke strumming key and the Range parameter is ignored. If no
note is played on the keyboard, the downstroke and upstroke keys trigger a strum over the range
defined by the Range parameter but the strings are muted. The effect is the same as using the
muffled down- and upstroke keys which are described below.

4.3.2 Palm Muted Down- and Upstroke

Palm muting is a technique used by guitar players to muffle the strings slightly while simultane-
ously playing the strings with the picking hand. It is obtained by placing the side of the picking
hand on the strings just before the bridge. Palm muted down- and upstroke are triggered by using
C] and D[ 5 respectively.
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Figure 15: Palm muting with the arp keys.

4.3.3 Muffled Down- and Upstroke

On a guitar, fretted notes can be muted by decreasing the pressure applied by the fretting fingers on
the string. The guitarist can control the effect by applying more or less pressure on the strings and
obtain a percussive effect by striking the strings with the picking hand. This effect is also known
as scratching.

Now, play a chord on the keyboard and use the muffled Down- and Upstroke keys (F] and G]
5). The strings are played as if the guitarist was muting them with the fretting hand. The effect is
the same as using the down- and upstroke keys without playing a chord on the keyboard, but these
strumming keys allow one to obtain the effect without releasing the chord.

4.3.4 Arpeggios

A chord can be arpeggiated using the bass, alternate bass, arp 4, arp 3, arp 2 and arp 1 strumming
keys (E5, F5, G5, A5, B5 and C6). The effect of these keys depends on the chord played by Strum
as explained in section 3.2.6. As many chords include only four strings (a bass and three high
notes) it is common for the arp 2 and arp 1 keys to play the same note. Furthermore, depending
on the position of the chord on the fretboard, the alternate bass key (arp 5 key), can play a lower,
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Figure 16: Scratching with the arp keys.

higher or the same note as the bass key (arp 6 key). The most useful arp keys are therefore usually
the bass, arp 4, arp 3 and arp 2 keys (E5, G5, A5 and B5). A good position to play arpeggios is to
use the thumb to play the bass, the index to play the arp 4 key, the middle finger for the arp 3 key,
the ring finger for the arp 2 key and finally the little finger for the arp 1 key. This position is similar
to that of a guitar player.

Here is a simple example of an arpeggio. Play a C chord (C-E-G) with the left hand, and then
use the right hand to trigger the Bass (E5), arp 4 (G5), arp 3 (A5) and arp 2 (B5) keys.
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Figure 17: A simple arpeggio.

When playing arpeggios, it might be interesting to use Movable-Lowest chord types in order to
obtain a motion of the bass. To try this, set the Type from the Chord section to Movable-Lowest and
play the arpeggio from the preceding example using the following chord progression: C (C-E-G),
CMaj7/B (B-C-E-G), C7/B[ (B[-C-E-G) and Am7 (A-C-E-G).
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Figure 18: Bass motion and arpeggios.
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4.4 Specific Techniques

4.4.1 Trills

This technique consists in switching rapidly between two notes by using hammer-ons and pull-offs.
With Strum, a trill is played by holding the first note and depressing and releasing the second note.
The interval between the notes must be one or two semi-tones.

4.4.2 Tremolo Picking

This technique consists in repeating the same note very rapidly. With Strum, it is possible to take
advantage of the fact that all arp keys play the same string when only one note is played on the
keyboard. It is therefore possible to trigger again the same note by switching rapidly between two
or more arp keys with the right hand.

4.4.3 Muted Strum

A muted strum is a stroke which is muted immediately after having been played by applying the
full hand on the strings. It is less dry than a scratch (muffled stroke) and brighter than a palm muted
stroke. One way to recreate this effect is to strum a chord using the down- and upstroke keys (C5
or D5) and playing the mute all key (B[5) very rapidly.

4.4.4 Partial Strumming

A guitarist does not always strum all the strings in a chord. This is why Strum offers the possibility
to adjust the strumming range. But guitarists also often vary the number of strings played between
strumming strokes. Strum therefore allows one to define a main and an alternate strumming range.
The main range is used when using the standard strumming keys while the alternate strum is acti-
vated by using the same keys but by also holding the alternate strum key (B4). The alternate strum
can also be activated by using the hold pedal when it is set to Alt. Strum mode which can be more
convenient.
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Figure 19: Changing the strumming range using the Alt. Strum key.
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Another technique to obtain partial strums consists in releasing strumming keys before the
strum is completed. In this way, the strings still not strummed, are not played. In other words,
partial strumming is achieved by playing staccato on the strumming keys while full strums are
obtained by playing them normally. This technique is easier to perform when the strumming speed
is relatively slow.
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Figure 20: Reducing the strumming range by playing staccato.

4.4.5 Bass & Chords

In certain musical styles, such as country and bluegrass music, one often finds rhythm-guitar pat-
terns obtained by switching between the root or fifth played on the bass string and a strum on the
remaining strings. To obtain this effect, it is therefore important that the lowest string is note in-
cluded in the stroked part of the pattern. In order to reproduce this effect with Strum, one must
first use the bass or alternate bass key (E5 or F5) and hold it while playing one of the stroke trig-
gers. Indeed, when Strum detects that a stroke key is played while the bass or alternate bass key is
depressed, it removes this string from the strum.
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Figure 21: Bass and Chord.

4.4.6 Stationary Bend

In this technique, the guitarists plays two notes simultaneously and bends one of the two notes. It
is possible to obtain the effect with Strum by taking advantage of the fact that only the last note
played is bended.
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When the Auto-Strum mode is switched on, one first plays the note which should not be bended
and then the second one. The bending effect is then obtained by moving the pitch wheel or using
the aftertouch. This will only work, however, for intervals larger than one tone because otherwise
Strum always automatically triggers a hammer-on or pull-off when intervals of one or two semi-
tones are played legato.

When the Auto-Strum mode is switched off, the two notes can be played at the same time on
the keyboard. The lowest is then triggered with the bass strumming key (E5) and the second note
with the arp 4 key (G5). The note to be bended is triggered last and the bending is activated either
using aftertouch or the pitch wheel.

4.4.7 Power Chords

Power chords are equivalent to playing a fifth interval. They are referred to as chords because
they can also be interpreted as a major chord played without the third. In Strum, power chords are
obtained by playing fifth intervals on the keyboard. When two notes are played simultaneously on
the keyboard, Strum detects an interval and therefore plays the notes on different strings. It is not
always possible to play notes simultaneously when playing live and it is therefore recommended to
play the highest note of the interval slightly before the lowest. Otherwise, Strum may decide to play
the highest note on the lowest string and then will also need to voice the lowest note on the lowest
string which will result in both notes being played one after the other. A power chord voicing on
three strings is obtained by playing the root, the fifth and the root again one octave higher on the
keyboard.

4.5 Using MIDI Loops

Reproducing complex patterns played on the guitar can rapidly become complicated and requires
to be a good keyboard player. The good news, however, is that patterns, in other words sequences
of chords and strumming keys, can easily be played using Strum’s MIDI loop player. Furthermore,
Strum is supplied with a library of MIDI loops which you can use to easily start creating a new
piece. The standard loop library is accessible directly from Strum’s interface by clicking on the
Load button of the loop player which will automatically bring you to the default MIDI loop library
folder. Loops can be used as they are or can easily be edited in a sequencer and then be played
using the Strum MIDI loop player.

It is important to note that Strum makes no distinction between MIDI signal coming from the
standard MIDI input (keyboard or sequencer) or the MIDI loop player. How Strum interprets the
MIDI signal it receives therefore depends whether the Auto-Strum mode is on or off. When it is
on, Strum will play chords as they are played on the keyboard and then trigger them again when
strumming keys are played in the loop. It is therefore usually simpler to switch the Auto-Strum
mode off, chords are then triggered following the pattern of strumming keys in the MIDI loop.
In other words, chords are plucked on the keyboard and strumming patterns are applied to them
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through the MIDI loop player. Note that loops are note limited to strumming keys and can also
include melodies and chords.

4.5.1 Creating MIDI Loops

Loops for Strum are easily created in your favorite sequencer by respecting the following rules:

• All the events must be on MIDI channel 1.

• The loop must begin at the start of the file and finish at the end of the track. In other words,
if the track lasts for four bars but there are notes only in the first bar, Strum will still loop
over the four bars.

• The tempo and the time signature must be defined at the beginning of the loop and must not
change during the rest of the loop. Strum indeed ignores tempo changes occurring in the
middle of a loop.

• The loop must be recorded on disk on a file using MIDI format 0 or 1 and having a .mid
extension.

Here are other advices which help to create more realistic loops:

• Always slightly vary the velocity of strumming keys in order to get a more lively result.

• If the loop is short, it may be preferable to repeat the same patterns many time with different
velocities for each repetition.

• If the loop includes chords, always make sure that they are well quantized and that there is
always a strumming key played at the same time. This will avoid unwanted strokes when the
loop is played while the Auto-Strum mode is switched on.

• Avoid using MIDI controllers whose effect can be changed by the user. For example, the
pitch wheel can either be used to create a bend or a slide; the hold pedal can either hold the
current chord or be used to trigger an alternate strum.

4.6 Chord Voicing

On the guitar, there are usually many different ways to play the same chord. Each of these positions
or voicing sounds differently and suits different musical styles. The specific voicing chosen by
Strum for a chord depends on the Type parameter from the Chord section of the interface. One can
choose between three types of chords:

• Open Chords. These are chords played with a combination of fretted notes and open strings.
These chords are usually played only within the first three frets of the fretboard. Open chords
are easy to play and extensively used when playing folk music. Note that all chords do not
necessarily have an open position on the guitar.
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• Movable Chords. These chords do not use open strings. As a result they can be moved
along the fretboard of the guitar allowing one to easily play the same voicing in different
tonalities. This type of chords includes barre chords which are obtained by using one finger to
press down multiple strings across the fretboard. Movable chords always use the maximum
possible number of strings and are therefore useful to play arpeggios. Furthermore they allow
one to play the same arpeggio patterns in different keys.

• Drop Chords. These are four note chords which allow for fast and subtle movement between
chords. The positions used by Strum are based on drop 2 and drop 3 chords. These chords
are obtained by dropping the second or third voice of a chord down one octave. Chords
played on the keyboard with three notes will always be played on three strings by Strum. If
the chord contains 4 or more notes, the corresponding voicing will always be played on four
strings. This type of chord sounds lighter and is extensively used in jazz.

In addition to these voicing categories, the voicing can be made more precise by specifying
what should be the lowest note of the chord played by Strum:

• Lowest. The lowest note in the guitar voicing chosen by Strum is the lowest note played
on the keyboard. This type of voicing is useful if it is necessary that the bass of the chord
sequence follows a specific movement.

• Root. The lowest note in the guitar voicing chosen by Strum is the root of the detected chord.
It is very common for guitar chords to have the root in bass position. This choice of chord
type allows one to play chords on the keyboard using any voicing and still obtain a guitar
chord in root position.

Finally, the Playing Position parameter from the Chord section allows one to specify the lowest
fret on which the lowest note of a chord should be played. This control gives Strum an indication
of the position on the neck where chords should be played and chords are voiced accordingly when
possible. This parameter is of course only valid for movable chords and it is therefore inactive
when open chords are chosen.

Although there is no general rule and there are many ways to play in different musical styles or
obtain different effects, we give some guidelines on chord types and performance settings which
should work well in specific situations:

• Folk. Open-Root and medium strumming speed.

• Country and Bluegrass. Open-Root with a high strumming speed.

• Pop-Rock. Moveable-Root.

• Arpeggios with bass motion. Moveable-Lowest or Open-Lowest.

• Jazz. Drop chords.

• Samba Bossa. Drop chords. Use the arp 6 strumming key to play the bass and arp keys 4, 3
and 2 simultaneously to play the rest of the chord.
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• Funk. Moveable-Root with Playing Position on a high fret.

• Flamenco Open-Root with a rapid strumming speed. Use the alternate strum on the four
highest strings.
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5 Presets and MIDI maps

Strum Acoustic comes with several factory presets covering a wide range of sounds. This collection
of presets lets you play and familiarize yourself with this synthesizer without having to tweak a
single knob. Soon, however, you will be experimenting and creating your own sounds and projects
that you will need to archive or exchange with other users. You may also want to control the
parameters of Strum Acoustic with a specific MIDI controller. In this chapter, we will review the
management of presets and MIDI maps.

5.1 Presets

There are two concepts involved in the management of presets, the preset library and programs.

5.1.1 The Preset Library

The preset library contains the factory presets, modified ver-
sions of the factory presets you might have made or any other new
presets you might have saved. The library may also contain im-
ported presets as well as MIDI maps as explained in Section 5.6
and 5.7. In other words, the preset library is a repository of all the
presets and MIDI maps available to Strum Acoustic.

All the operations on the preset library are conveniently man-
aged with the help of the Strum Acoustic browser, similar to those
found in most email programs which use a hierarchical tree structure and a visually intuitive, drag
and drop approach. To explore the different presets available in the library, open the different fold-
ers by clicking on the “+” icon Windows or I symbol on Mac OS to the left of folders. Each preset
is represented by a blue knob icon followed by its name.

5.1.2 The Program list

Presets are loaded into the synthesis engine of Strum Acous-
tic from a list of 128 numbered presets called programs. The
name of the current program and its number are displayed in the left of the toolbar at the top of the
application window. The entire list of programs can be viewed by clicking on the H button left of
the program number.

It is important to note that presets in the program list and in the preset library are stored in
different locations. They are in fact different copies of the same presets which may, as explained
below, differ even if they share the same name. The version of a preset available in the program
list should be viewed as temporary or as a ‘working copy” of the preset whereas the version in the
library should be viewed as permanent or as the ‘reference version”.
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When you start the application for the first time, the program list contains a selection of presets
from the factory preset library. At that point, the presets in the program list are identical to their
version in the library.

5.2 Playing and Changing Presets

Presets are always played from the program list. The name of the current program, in other words
the one currently loaded in the synthesis engine, as well as its number are displayed in the left part
of the toolbar. Its number and name are also preceded by a check mark in the program list. The
current program can be changed in different ways:

• scroll up or down in the program list by clicking on the ‘+” and ‘−” buttons located on the
left of the program name or use the ‘+” and ‘−” keys from the computer keyboard,

• Display the content of the program list by clicking on the H button and select a program by
clicking on its name.

• Use the Switch to Program command from the Programs menu and enter a specific pro-
gram number. This command can also be activated by using the Ctrl-P/Apple-P keyboard
shortcut.

• Send MIDI program changes from your MIDI controller. Strum Acoustic will load the pro-
gram having the same number as the program change number received by the application.

A Preset can also be loaded from the preset library. It is then stored in the current program
replacing the preset that was already stored in this location. It then becomes immediately available
to the synthesis engine. Different options are available to load a preset from the preset library into
the current program:

• In the browser, double-click on a preset icon.

• Drag and drop presets from the browser onto the Strum Acoustic interface.

• Select a preset by clicking on its icon and use the Enter key from the computer keyboard.
Once a preset has been selected in the library, it is possible to navigate in the library using the
Arrow keys from the computer keyboard. A preset is selected when its name is highlighted.

• Select a preset and use the Open Preset command from the File menu or the Ctrl-O/Apple-O
keyboard shortcut.

Note that when a preset is loaded from the preset library to the list of programs, the program
name displayed in the toolbar changes but not its number. This indicates that the current program
number used by the synthesis engine is still the same but that the preset corresponding to that
program has changed. The 128 programs can therefore be customized by selecting different pro-
gram numbers (by using the ‘+” and ‘−” buttons from the toolbar or selecting programs from the
program list) and loading presets from the library.
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5.3 Editing and Saving Presets

Moving the different controls on the Strum Acoustic interface modifies the preset loaded in the
current program. As soon as the current program is modified, the preset icon located on the left of
the program name in the toolbar changes color and a ‘*” sign is appended to its name in the program
list. In this state, the preset loaded in the current program is different from its original version stored
in the preset library even if they share the same name. If you wish to keep a permanent copy of the
modifications, you must save this new version in the preset library.

• To save the new version in the preset library, use the Save Preset command from the File
menu or the Ctrl-S/Apple-S shortcut. Be careful, however, as using this command will over-
write the original preset. If you are not certain of which preset will be overwritten in the
library, first use the Locate Program in Browser command from the Programs menu or the
Ctrl-L/Apple-L shortcut in order to locate it in the browser.

• To create a new preset, use the Save Preset As command from the File menu. A window will
appear asking for a name for the new preset. Once the preset is saved using this command, a
new preset icon will appear in the browser directly under the Library folder.

• To create a new preset, it is also possible to rename the program using the Rename Current
Program from the MIDI menu (or the Ctrl-R/Apple-R keyboard shortcut) and use the Save
Preset or Save Preset As commands.

When editing presets, it is very helpful to go back and forth between the different stages of your
modifications and adjustments. To move back step by step through every modification that was ap-
plied to a preset, use the Undo command from the Edit menu or the Ctrl-Z/Apple-Z shortcut. Once
the Undo command has been used, it is also possible to move up again through the modifications
by using the Redo command from the Edit menu or the Ctrl-Y/Apple-Y command. The number
of Undo levels is unlimited and this command is effective on any control of the interface but not
on the different Save commands.

Once a preset has been modified, it is also possible to move back and forth between the current
state of the preset in the program list and its original version archived in the preset library. To
hear the original preset, simply click on the Compare button at the top of the interface or use the
Compare command from the Edit menu. Once this button has been pressed, the original settings
of the preset are loaded. In this mode, the graphical interface is frozen and it is therefore not
possible to modify the preset. To further modify the preset, click on the Compare button again or
uncheck the Compare command in the Edit menu to revert to the modified version of the preset and
unfreeze the interface. To reload the original version, use the Locate Preset in Browser command
from the View menu, or the Ctrl-L/Apple-L shortcut and double click on its icon in order to reload
this version into the current program.

Strum Acoustic will make sure that you do not loose modifications to a preset. In the case
where a program holds a modified version of a preset and when trying to load a new preset from
the library into this program, the application will ask you if you want to save the modified preset



42 Presets and MIDI maps

in the library. This behavior might not always be convenient and it is possible to deactivate it by
deselecting the Ask to save preset before opening another option in the Preferences command
from the Edit menu.

5.4 Saving the Program List

When you open Strum Acoustic, the applications always loads the same program list. This implies
that, by default, the program list will always contain the same presets when you open the application
and that your modifications to presets will be lost unless they have been saved in the preset library.

• To save the current list of programs and replace the default program list, use the Save All
Programs command from the Programs menu.

This command is helpful if you wish to modify the program list or if you wish to restart the
application in exactly the same state as when you left it.

Note that this operation is not necessary when using Strum Acoustic as a plug-in in a host
sequencer as the program list is always saved with a project. The default program list will be
loaded only if a new project is started or if a new instance of Strum Acoustic is opened within a
project.

5.5 Organizing the Preset Library

5.5.1 Creating Folders

Sub-folders can be created by first selecting a folder by clicking on it and using the New Folder
command from File menu.

5.5.2 Copying and Moving Presets and folders

Presets and folders can be copied and moved from one location to another. First select an item by
clicking on its icon and use the Copy command from the Edit menu (Ctrl-C/Apple-C shortcut) in
order to copy it. Then click on the destination folder and use the Paste command from the Edit
menu (Ctrl-V/Apple-V shortcut) in order to paste it. Groups of items can be copied and pasted
at the same time. In order to select many items at once, click on different icons while keeping
the Control/Apple key depressed. Alternatively to select, within a folder, all the presets located
between two presets, click on the first one and then on the second one while keeping the Shift key
depressed. Once a group of items has been selected, use the Copy and Paste functions as explained
above.
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5.5.3 Renaming Presets and folders

On Windows systems, to rename a preset or folder, click a first time on the corresponding icon in
the browser in order to select it. Then click a second time to enter in name edition mode. Note that
this sequence of operation is different from double-clicking on the icon which loads the preset in
the case of a preset icon or opens a folder in the case of a folder icon. In other words, there must
be a pause between the two clicks.

On Mac systems, first select the item to be renamed and the use the Rename command from
the Edit menu. It is also possible to ctrl-click on the selected item and then choose the Rename
command.

5.5.4 Deleting Presets and Folders

To delete a preset or folder, first select it by clicking on its icon in the browser, then use the Delete
command from the Edit menu or use the Del key from the computer keyboard. In order to select
and then delete many items at once, click on different icons while keeping the Control/Apple key
depressed. Alternatively to select, within a folder, all the presets located between two presets, click
on the first one and then on the second one while keeping the Shift key depressed. Once the group
of items has been selected, use the Delete function as explained above.

5.5.5 Documenting Presets

It is possible to document a preset and view related information. To view or edit information on a
preset, first select it in the browser and choose the. Preset Info command from the Edit menu or
use the Ctrl-I/Apple-I shortcut. It is also possible to right-click/control-click on the preset icon and
choose the Preset Info command. Information on a preset includes the author’s name, copyright
notice, date of creation, last modification date and a text description.

5.5.6 Locating a Preset in the Browser

It might sometimes be helpful to locate in the preset library the preset currently being played or
in other words, that corresponding to the current program. To rapidly locate the current preset
in the browser, use the Locate Program in Browser command from the Programs menu or the
Ctrl-L/Apple-L shortcut. The Locate command will automatically expand the folder containing
the currently used preset and select the preset.

5.5.7 Resizing the Browser

In standalone mode, the browser can be resized. In order to change the size of the browser, position
the mouse cursor on the line separating the browser from the Strum Acoustic control panel. When
the cursor changes to a double-headed arrow, click-hold and move the mouse to the left or right as
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desired. In order to hide the browser completely, move the double-headed arrow cursor fully to the
left. Note that when Strum Acoustic is used as a plug-in, the browser size is fixed and can not be
modified.

5.6 MIDI Maps

MIDI maps containing information about MIDI links between the MIDI controllers and the Strum
Acoustic interface can easily be created as will be explained in Section 8.2. MIDI maps are rep-
resented in the browser with a MIDI connector icon. MIDI maps are treated exactly the same
way as presets in the browser and are saved using the Save MIDI Links or Save MIDI Links As
commands from the File menu.

5.7 Exporting and Importing Presets and MIDI maps

The Import and Export commands, found in the File drop down menu, allow one to easily ex-
change presets and MIDI maps with other Strum Acoustic users. This feature can also be used to
decrease the number of elements in the browser by archiving older or rarely used ones elsewhere,
on CD-R, or a second hard disk for example. Files containing Strum Acoustic presets and MIDI
maps are equivalent in size to short text file, making it easy to send presets to other users via email.

To export a folder, a group of folders, presets or MIDI maps within a folder, select the elements
to export in the browser and use the Export command from the File menu. When the Export
window appears, choose a file name and a destination location on your hard disk. Strum Acoustic
export files will be saved with an “strumA” extension.

Importing presets and MIDI maps is just as easy. Simply click on the Import command from
the File drop down menu, and select the file to import. A new folder will then appear under the
Imports directory in the browser, containing all of the files contained within the imported package.
These can then be dragged and dropped to a new folder, or remain in the Imports directory.

5.8 Backuping Presets and MIDI Maps

There are basically two ways to backup your presets and MIDI maps: exportation and database
backup. The database backup is more efficient when there is a large number of elements to backup.

The exportation methods consists in using the Export command from the File menu as ex-
plained in section 5.7. Once you have exported the elements you wish to archive, just save the
export file(s) to your usual backup location or medium.

The second backup method will enable you to archive the entire material present in the browser.
The content of the browser, including presets, MIDI maps and folders is saved into a database file.
This second backup method simply consists in archiving this file. The database file location is
different whether you are working on a Mac OS or Windows system.
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• On Windows systems: C:\Documents and Settings\[User]\Application Data\Applied Acous-
tics Systems\Strum Acoustic 1.0.

• On Mac OS systems: [System Drive]:Users:[User]:Library:Application Support:Applied
Acoustics Systems:Strum Acoustic 1.0.

The name of the database file is StrumAcoustic.tdb. In order to archive your database, just
copy this file to your usual backup location or medium. In order to restore a database, replace
the version of the StrumAcoustic.tdb file with a previously archived one. It is also possible to
synchronize different systems by copying this file on different computers where Strum Acoustic is
installed.

5.9 Restoring the Factory Presets and MIDI Links

If necessary, it is possible to restore the original factory library and program list by using the
Restore Factory Library from the File menu. This operation makes a backup of your current
database file in the preset database folder as explained in Section 5.8 and creates a new preset
database containing only the factory presets and MIDI maps. The next time you open Strum Acous-
tic, both the browser and the program list will be in exactly the same state as when you first installed
the application.

Note that restoring the factory library should be done with caution as you will loose all the
work you might have saved into the library and that this operation can not be undone easily. If you
wish to recuperate a certain number of presets and MIDI maps after restoring the factory library,
we recommend that you first export all the material you wish to keep using the Export command
as explained in Section 5.7. After re-installation of the factory library, you will easily be able to
re-import this material using the Import command.

If you forgot to export material before restoring the factory library or if you wish to bring
back the preset library to its state before restoring the factory library, it is still possible to recover
material from the backup file of the preset database which was created automatically when restoring
the factory library as explained in Section 5.8. This method should be considered as a last resort,
however, as recovering material from this backup file will remove the factory library which you
have just installed and force you to redo the operation. Using the Export command before restoring
the factory library is much simpler.

Note that the restore of the factory library is actually performed the next time you re-open the
application. It is still possible to cancel this operation before exiting the application by using the
Cancel Library Restore command from the File menu.
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6 Parameters

This section can be used as a reference on the different controls appearing on Strum’s graphical
interface. We begin by describing the behavior of the different types of controls appearing on the
interface

6.1 General Functioning of the Interface

6.1.1 Tweaking Knobs

All the knobs on the interface are selected by clicking on them. Once selected, they can be con-
trolled in different ways depending on the effect you want to achieve.

• For coarse adjustment click-hold on a knob and drag the mouse upwards or downwards to
move it clockwise or counter-clockwise.

• For fine adjustment, use the left or down arrow of the computer keyboard to move the knob
counterclockwise and the right or up arrow to move it clockwise. The Page Up and Page
Down keys give the same result with slightly faster action.

• To move a knob to a given position, place the mouse at this position and Shift-click (Win-
dows) or Option-click (Mac OS). To reach this position slowly, do the same, but use the
middle button of the mouse (Windows only).

• Knobs with bi-directional arrows in the middle of their contour can be adjusted directly to
their center position by double-clicking on them.

• When viewing parameters for individual strings, it is possible to set the value of a parameter
for all strings at once. To do so, Ctrl-click (Windows) or Command-click (Mac OS) on a
knob and move it.

Remember that the keyboard shortcuts affect only the most recently selected control. The value
of the control currently selected is displayed on the toolbar at the top of the Strum window. The
number displayed on the counter is a value corresponding to the current value of the corresponding
parameter.

6.1.2 Buttons

Buttons are switched on or off by clicking on them. The status of a button currently selected is
displayed in the toolbar.
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6.1.3 Drop-down Menus and Displays

Clicking on a display with a small down-pointing triangle on its right, such as the Type control of
the Multi-Effect module, reveals a drop-down menu with a set of possible settings for the control.
Adjustment of the control is obtained by clicking on a selection or using the up and down arrows
and the Enter key of the computer keyboard.

6.1.4 Bypassing a Module

The different effect modules of Strum can be turned on or off by clicking on the button appearing
on the right of the module label. A module is active when the button is in its on position and is
lit. Note that when a module is not activated, calculations associated with this module are not
performed, reducing CPU usage.

6.1.5 Modulation Signals

Some parameters, such as the Speed parameter from the Strumming section, can be modulated with
MIDI velocity. When it is the case, a Velocity knob appears below the parameter and both knobs
are linked by a thin vertical line.

6.2 The Guitar Modules

This is the main view of the instrument and is activated when the All button, located in the
upper left corner of the guitar shape, is switched on. In this mode the different modules forming
the guitar are visible, each with a few control parameters. This mode is used to play the different
presets and, if necessary, easily make adjustments. Only a selection of the parameters actually
used by the synthesis engine are visible in this view. The full range of parameters for each string
is accessible by clicking on the numbered buttons next to the All button, each representing a string
number. These different parameters are described in section 6.6.
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The Global, Pick/Fingers, Strings, Hammer, Mute and Palm modules are related to the
modeling of the individual strings of the guitar. The Body module on the right of the guitar shape
represents the body of the guitar and allows one to adjust its behavior. The different knobs in this
view are so-called offset knobs. Each of them is related to a specific parameter of the strings or body
of the instrument. They are used to vary the value of a parameter around its current value, in other
words the value visible when selecting individual strings. In the case of the strings parameters,
these offset knobs alter the value of the same parameter for the six strings at once.

Note that after varying parameters with these offset knobs, it is possible to apply the changes
to the parameters. This is done by clicking on the down-pointing arrow located on the right of
the module labels and selecting the Apply Offset command. This will add the offset value to the
current value of the parameter, move back the offset knob to its center position and update the knob
position in the individual string views.

6.2.1 The Strings Module

In an acoustic guitar most of the sound we hear is radiated from the body
of the instrument. The strings themselves radiate just a small amount of sound
directly but it is their vibrations that are transmitted to the body of the guitar,
through the bridge, where they can be radiated efficiently. It is also the strings
that fixes the pitch of the sound we hear depending on their effective lengths.

In a real guitar, the material of the sting affects the sound of the instru-
ment. For example, the sound of a metal string is brighter than that of a nylon
one. The Tone knob controls the decay time of high frequencies in the sound
relatively to that of low frequencies which is a parameter related to the ma-
terial of the string. Turning this knob clockwise enhances high frequencies
resulting in a more metallic sound while turning the knob anti-clockwise has
a damping effect on high frequencies.

Strings are usually considered to be harmonic meaning that all the frequency components of
the sound appear at frequencies that are multiple integers of the fundamental frequency of the note
being played. Real strings, however, are not perfectly harmonic due to the fact that there width is
not exactly constant along their entire length. As the inharmonicity is increased, we will say that
the sound becomes more and more dissonant. In Strum, the amount of inharmonicity in the sound is
controlled using the Inharm knob. Turning this knob clockwise detunes the partials toward higher
frequencies while turning it anti-clockwise reduces the inharmonicity of the strings.

The Coupling knob is used to control the amount of beating in the sound. Turning this knob
to the right increases the amount and frequency of the beating while turning it to the left reduces
it. This beating effect is characteristic of real guitar strings, it is due to the coupling between two
different components in the motion of the string as will be explained in more details in Secion 6.6.1
hence the name of this knob.
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6.2.2 The Pick/Fingers Module

The Pick/Finger module allows one to control the excitation
of the string with a pick or fingers. The Stiffness parameters de-
termines the flexibility of the plectrum or in other words the re-
sistance it exerts against the string. Increasing the value of this
parameter mainly increases the amplitude of the sound. The Edge
parameter is used to control the rounding of the edge of the plec-
trum. Turning this clockwise increases the sharpness of the edge
resulting in a brighter sound. The Position parameter allows one
to modify the pick position on the strings while playing. This is a
parameter used by guitarists to change the tone of the sound. In-
deed playing near the bridge results in a dryer and more metallic
sound while playing over the hole of the body or toward the fretboard results in a fuller sound. In
its leftmost position, the pick is very close to the bridge. Moving this knob clockwise moves the
pick toward the fretboard.

6.2.3 The Hammer Module

The Hammer module is used to control hammer-on and pull-off effects. Hammer-
ons and pull-offs are playing techniques used by guitar players to play legato or grace
notes. The hammer-on effect is obtained by first picking a note and then hammering
down another finger onto the same string at a higher fret. The pull-off effect is almost
the opposite of the hammer on. It is obtained by first picking a note and then sharply pulling-off
the finger from the fretboard in order to hear a second fretted note on the same string. The sounds
produced using these techniques are softer and less percussive than the ones produced by picking
the notes.

In Strum, hammer-ons and pull-offs are triggered when legato playing on the keyboard is de-
tected. The Amp knob is used to control the amplitude of the excitation when a hammer-on or
pull-off is triggered and therefore determines the strength of the effect. Turning this knob to the
left reduces the amplitude of the excitation while turning the knob clockwise increases it.

6.2.4 The Mute Module

The Mute module is used to control the sound of the string when it is muted. On
a guitar, fretted notes can be muted by decreasing the pressure applied by the fretting
fingers on the string. The guitarist can control the effect by applying more or less
pressure on the strings and obtain a percussive effect, also called scratching, by striking
the strings with the picking hand.

In Strum, scratching is achieved by using special down and upstroke strumming keys as ex-
plained in section 3.2. The resulting sound of this effect can be adjusted with the help of the Tone
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knob. This parameter is used to control the amount of high frequencies in the resulting sound;
turning this knob to the left decreases the amount of high frequencies relatively to low frequencies
while turning it to the right increases it.

6.2.5 The Palm Module

Palm muting is a technique used by guitar players to muffle the strings slightly while
simultaneously playing the strings with the picking hand. It is obtained by letting the
side of the picking hand touch the strings just before the bridge.

In Strum, palm muting is achieved by using special strumming keys as explained
in section 3.2. The resulting sound of this effect can be adjusted with the help of the Tone knob.
This parameter is used to control the amount of high frequencies in the resulting sound; turning
this knob to the left decreases the amount of high frequencies relatively to low frequencies while
turning it to the right increases it.

6.2.6 The Global Module

The Velocity knob is used to decrease or increase the modulation effect from the
MIDI velocity signal. This parameter affects all the parameters modulated by the MIDI
velocity.

6.2.7 The Body Module

The role of the body or soundboard of an acoustic guitar is to radiate the vibra-
tion energy from the strings. The body also adds a filtering effect to the vibration
from the string which depends on its size and shape. The body of an acoustic guitar
also includes an air cavity which boosts low frequencies.

The Body module of Strum includes only one control in the main view. The
Tone knobs is used to control the amount of high frequencies radiated by the body
which affects the timbre of the instrument. Turning this knob clockwise increases
the decay time of high frequencies compared to that of low frequencies while turn-
ing it anti-clockwise decreases it.

6.3 The Equalizer Module

The EQ module provides equalization over the low, mid, and high frequency bands and is switched
on or off using the On button. It is composed of a low-cut filter, a low shelf filter, a peak filter, and
a high shelf filter in series.
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The low-cut (or high-pass) filter is used to
remove from the output sound of the instru-
ment frequency components below the cut-off
frequency. The cut-off frequency of the fil-
ter is increased by turning the knob clockwise.
when this knob is in its leftmost position, the
filter has no effect on the sound.

The functioning of the low shelf filter is illustrated in Figure 22. The filter applies a gain factor
to frequency components located below a cutoff frequency while leaving those above unchanged.
The cutoff frequency of this filter is fixed and located at 500 Hz. The amount of gain is controlled
with the Low knob. In its center position there is no attenuation (0 dB). Turning it clockwise will
boost the amplitude of low-frequencies will turning it anti-clockwise will reduce it.

The high frequency content of the signal is controlled with a high shelf filter that works in
the opposite manner as the low shelf filter as illustrated in Figure 22. The filter will multiply a
gain factor to components located above a cutoff frequency while leaving those below unchanged.
The cutoff frequency of this filter is located at 3 KHz and the amplitude of the high frequencies is
controlled using the Hign knob which works similarly to the Low knob.

Amplitude (dB)

0dB

Freq Frequency (Hz)

Amplitude (dB)

0dB

Frequency (Hz)Freq

Gain = −30 dB

Gain = 10 dB

Gain = 20 dB

Gain = 30 dB Gain = 30 dB

Gain = 20 dB

Gain = 10 dB

Gain = −30 dB

Figure 22: Low and high shelf filters.

The mid frequency content of the signal is adjusted using a peak filter as illustrated in Fig-
ure 23. The filter applies a gain factor to frequency components in a band located around the cutoff
frequency of the filter. The cutoff frequency of the filter is adjusted with the Freq knob while the
gain coefficient is varied with the Mid knob. When the Mid knob is in its center position there is no
attenuation (0 dB). Turning it clockwise will boost the amplitude of low-frequencies will turning it
anti-clockwise will reduce it.

6.4 The Multi-Effect Module

The Multi-Effect module allows one to process the output signal from the guitar and add effects to
the sound. Available effects include three different types of delays (ping pong, digital and tape), a
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Figure 23: Peak filter.

mono and stereo chorus, a mono an stereo flanger, a vibrato, a phaser, an auto wah, a wah wah and
a notch filter.

The different effects can be synchronized to the clock of a host
sequencer using the Sync drop-down menu. Sync values range
from 1/8 of a quarter note (a thirty-second note) to 16 quarter notes
(4 whole notes) where the duration of the whole note is determined
by that of the sequencer clock. The effect can also be synced to a
triplet (t) or dotted note (d).

Each of the effect of the module can be controlled using three
offset knobs. When in their center position, the effect is adjusted
according to the factory settings. Turning the knobs to clockwise or anti-clockwise allows one to
deviate from this default setting as described below.

6.4.1 Delay

The Multi-Effect module includes 3 different types of delay effects: Ping Pong, Digital and Tape
Delay. The Digital delay consists in a standard delay line with feedback. The tape delay is similar
but also includes a low-pass filtering effect in order to simulate the attenuation of high frequencies
in analog tape delays. The Ping Pong delay is based on two delay lines resulting in a signal traveling
from one channel to the other, each time attenuated by a coefficient.

The Wet knob is used to adjust the amount of “wet” signal present in the output signal from the
effect. When the knob is adjusted in the left position, only the original or “dry” signal is sent to the
output. Turning this knob clockwise increases the amount of processed or “wet” signal sent to the
output. In its rightmost position, only “wet” signal is present in the output signal. The Feedback
knob is used to adjust the amount of signal re-injected into the delay lines or in other word the
amount of feedback introduced in the line. In its leftmost position, there is no signal re-introduced
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and the effect module only delays the input signal. Turning this knob clockwise increases the
amount of signal reflected back at the end of the line. Finally the Time knob controls the length of
the delay lines and therefore the delay between echoes.

6.4.2 Chorus

The Multi-Effect module includes both a mono and stereo chorus effect. The chorus effects can
be controlled with the three knobs appearing at the bottom of the module. The Mix knob is used to
adjust the ratio of “dry” and “wet” signal in the output signal from the module. When the knob is
adjusted in the left position, only the original or “dry” signal is sent to the output while in the right
position only the processed or “wet” signal is sent to the output. The Depth knob is used to control
the amplitude of the effect while the Rate knob is used to fix the modulation frequency of the effect
if the Sync function is off.

6.4.3 Flanger

The Multi-Effect module includes both a mono and stereo flange effect. The flanger effects can
be controlled with the three knobs appearing at the bottom of the module. The Mix knob is used to
adjust the ratio of “dry” and “wet” signal in the output signal from the module. When the knob is
adjusted in the left position, only the original or “dry” signal is sent to the output while in the right
position only the processed or “wet” signal is sent to the output. The Depth knob is used to control
the amplitude of the effect while the Rate knob is used to fix the modulation frequency of the effect
if the Sync function is off.

6.4.4 Vibrato

The vibrato effect introduces a periodic low frequency pitch modulation in the signal.

The Rate knob is used to set the frequency of the vibrato effect when the Sync function is off.
The Depth knob enables one to control the depth of the effect, or in other words the amplitude of
the frequency variations. In its leftmost position, there is no vibrato and turning the knob clockwise
increases the amount of pitch variation. The Mix knob is used to determine the proportion of “dry”
and “wet” signals in the output signal from the effect. In its leftmost position, the output is “dry”,
turning the knob clockwise increases the amount of “wet” signal until, in its center position, there
is only “wet” signal. Note that turning further the knob clockwise has no effect.

6.4.5 Phaser

The “phasing” effect colors a signal by removing frequency bands from its spectrum. The effect is
obtained by changing the phase of the incoming signal and adding this new signal to the original.
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The phaser effects can be controlled with the three knobs appearing at the bottom of the module.
The Mix knob is used to adjust the ratio of “dry” and “wet” signal in the output signal of the module.
When the knob is adjusted in the left position, only the original or “dry” signal is sent to the output
while in the right position only the processed or “wet” signal is sent to the output. The Depth knob
is used to control the amplitude of the effect while the Rate knob is used to fix the modulation
frequency of the effect when the Sync function is off.

6.4.6 Wah

The Multi-Effect module includes 2 different types of wah effects: wah wah, and auto wah. Both
of them are based on a specially designed bandpass filter with a 12 dB/oct slope. In the wah wah
effect, the center frequency of the bandpass filter varies at a certain rate. In the case of the auto-
wah, the variations of the center frequency is controlled by the amplitude envelope of the incoming
signal.

The Freq knob is used to control the central frequency of the filter. Turning this knob clockwise
increases the center frequency. In the case of the Wah Wah effect, the center frequency will oscillate
around the value fixed by the Freq knob while with the Auto Wah effect, the setting of the Freq will
fix the starting point of the value of the center frequency.

The Depth knob controls the excursion of the center frequency of the filter. In the case of
the Wah Wah effect, this excursion is applied around the value fixed by the Freq knob while in
Auto Wah effect the value of the center frequency increases from the value fixed by the Freq knob.
Turning this knob clockwise increases the excursion of the center frequency.

Finally, the Rate knob controls the frequency or rate of the modulation of the center frequency
of the filter. In the case of the Wah Wah effect, turning this knob clockwise increases the rate of the
modulation if the Sync function is off. In the case of the Auto Wah filter, this knob controls the time
constant of the envelope follower. Turning this knob clockwise decreases the time constant, or in
other words the reaction time, of the envelope follower.

6.4.7 Notch Filter

The notch filter does essentially the opposite of a band-pass filter. It attenuates the frequencies
in a band located around the center frequency and leaves those outside of this band unchanged as
shown in Figure 24. As was the case for the Wah Wah effect, the filter is based on a filter having a
12 dB/oct slope and can be modulated.

The Freq knobs is used to control the central frequency of the filter. Turning this knob clock-
wise increases the center frequency. The Depth knob controls the excursion of the center frequency
of the filter around its center frequency. Turning this knob clockwise increases the excursion of the
center frequency. Finally, the Rate knob controls the frequency or rate of the modulation of the
center frequency of the filter. Turning this knob clockwise increases the rate of the modulation if
the Sync function is off.
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Figure 24: Frequency response of a notch filter.

6.5 Reverb

The Reverb module is used to recreate the effect of reflec-
tions of sound on the walls of a room or hall. These reflections
add space to the sound and make it warmer, deeper, as well as
more realistic since we always listen to instruments in a room
and thus with a room effect.

The Reverb drop down menu is used to choose between dif-
ferent reverb algorithms representing different types of rooms or
halls. Each algorithm can be adjusted with the knobs located at the bottom of the module. The Mix
knob is used to set the relative amount of “dry” and “wet” signal which is related to the proximity of
the sound source. The Decay is used to control the reverberation time of the room. In a real room,
the reverberation time is not constant across the whole frequency range because the walls of the
hall are generally more absorbent at high frequencies which results in a shorter reverberation time
for these frequencies. This effect is controlled with the Color knob which sets the reverberation
time of high frequencies relatively to the value of the Decay knob.

6.6 Edit Mode

This mode allows one to view and adjust all the parameters used by the synthesis engine. While
for most applications, simply using the presets will be sufficient, one might want in certain cases
to access the different instrument parameters and control them precisely. This mode is activated by
clicking on one of the string numbers appearing in the top of the guitar shape. Strings are numbered



56 Parameters

Figure 25: Editing parameters for string number 6 (E2).

from 6 to 1 with 6 being the lowest string (E2) and 1 being the highest one (E4). Clicking on the
different string numbers reveals parameters for this specific string which implies that all strings can
be tuned independently.

It is important to know that parameters from the different parameter sections can be copied
from string to string or all of them at once by clicking on the down-pointing arrow located next
to the section name label and choosing one of the proposed destination. Remember also that a
specific parameter can be adjusted for all the strings simultaneously by ctrl-clicking (Windows) or
Command-clicking (Mac OS) on the corresponding knob and moving it.

Finally, note that some of the parameters are framed by a lighter color background. This simply
means that these parameters can be controlled from the general view obtained when clicking on the
All button.

6.6.1 The Strings Module

The vibrational motion of a string can be decomposed into two different components, one perpen-
dicular to the plane of the body of the guitar and the other one parallel to that plane. At the bridge,
the string is fixed and energy is transfered to the body of the guitar but also exchanged between
these two components of the string motion. This exchange is responsible for both the characteristic
beating effect present in the sound of the guitar and the typical decay curve or envelope of the
sound. Both these motion components are modeled in Strum and they are referred to as polarity A
and B.
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For each polarity, one can adjust three parameters called Decay,
Tone and Inharm. The Coupling knob is used to adjust the amount
of energy exchanged between the two polarities of the string motion.
Turning this knob clockwise increases the coupling and therefore the
amount and frequency of the beating in the sound. When this knob is
in its leftmost position, there is no coupling between the two polari-
ties. Both of these components exist but completely independent of
each other resulting in a sound with no beating and a regular decay
envelope. The Balance knob is used to control the mix between both
polarities in the output sound. In its leftmost position, one only hears
polarity A while in its rightmost position only polarity B is heard. In
its middle position, an equal mix of both is heard. In general, to get
the most realistic realistic sound, the knob should be turned toward the left or in other words one
should listen more to polarity A. This is because in a real guitar, vibrational motion perpendicular
to the body is more efficiently transmitted. Interesting effects can however be obtained by mixing
both polarities. Note that even when the balance knob is fully turned to the left, coupling between
both polarities is still taken into account as soon as the Coupling knob is turned to the left which
will introduce beating in the sound of polarity A.

In a real string, the material of the string affects how it vibrates. For example, a metal string
oscillates for a longer time than a nylon one; its sound also contains more high frequencies and is
brighter. This behavior is adjusted with the Tone and Decay knobs. The Tone knobs are used to
set the respective amount of high frequencies in polarity A or B of the string motion with respect
to low frequencies. In their leftmost position, the decay time of high frequencies in the sound is
lower than that of low frequencies; in their rightmost position it is longer. The overall decay time
of the vibrations is controlled with the help of the Decay knobs and it is increased by turning the
knobs clockwise. As a rule of thumb a nylon string is obtained by setting the Tone knobs to the
left position and using a low decay time. Turning these knobs to the right and increasing the decay
time results in a more metallic sound.

In a first approximation, the strings of a guitar can be considered to be harmonic meaning that
their partials are located at frequencies equal to multiples of its fundamental frequencies. Real
strings, however, are more or less inharmonic depending on the homogeneity of the strings along
their length. This characteristic of strings is adjusted, for polarities A and B, with the Inharm knobs.
When these knobs are turned fully to the left, the string vibration is perfectly harmonic. Turning
the knobs clockwise increasingly detunes the partials toward higher frequencies resulting in a more
dissonant sound.

The Gauge parameter is used to set the amount of coupling between the string and the body
of the guitar which determines how efficiently vibrations from the string are transmitted to the
body of the instrument. Physically, this amount of coupling is determined by the ratio between the
impedance of the string and that of the body at the bridge. The mass per unit length and tension of
a string determine its impedance. As in a guitar all the strings have more or less the same tension,
this impedance of the string is mainly determined by the gauge of the string. Turning the Gauge
knob clockwise increases the gauge of the string and thereby its coupling with the body resulting
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in a stronger presence in the final sound.

6.6.2 The Pick/Fingers Module

The Pick/Finger module allows one to control the parameters related with the excitation of the
string. It can simulate the excitation of the string with a pick or with a finger. Three different
pick/finger or plectrum models are implemented in Strum as shown in Figure 26, 27 and 28 each
of them corresponding to a different plectrum profile. The first two models are better to simulate
the interaction of the string with a hard pick while the third one is better to simulate the interaction
with a smoother object such as a smooth pick or a finger. The plectrum model is chosen using the
Type selector.
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Figure 26: First pick model
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Figure 28: Third pick model
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The excitation force produced by the plectrum when interacting
with the string is determined by the Jut, Speed, Stiffness and Damp-
ing parameters. The Stiffness and Damping parameters determine
the flexibility of the plectrum or in other words the resistance it ex-
erts against the string. Increasing the value of these parameters will
mainly increase the amplitude of the sound. The Stiffness parameter
is used to control the stiffness of the plectrum used. Increasing this
parameter, by turning the knob clockwise, results in thicker or stiffer
plectrum. The Damping parameter controls the amount of damping
in the plectrum. The parameter is mainly effective during the attack
of notes. Raising its value, by turning the Damping knob clockwise,
results in additional impact noise when the plectrum first comes into
contact with the string when attacking a note. These two parameters are modulated with the note
velocity trough the use of the Velocity knob. When the knob is in its leftmost position, there is
no modulation from the MIDI note velocity; turning this knob clockwise gradually increases the
amount of modulation.

The Jut parameter enables one to control the distance between the edge of the plectrum and the
string when they come into contact. In other words it simulates how far behind the string, a guitar
player introduces the plectrum before picking the string. This parameter affects the loudness and
the spectral content of the sound as well as the the interaction time between the plectrum and the
string. This parameter can also be modulated with the MIDI note velocity signal using the Velocity
knob below. The Speed knob is used to control the speed of the plectrum relatively to the string.
The main effect of this parameter is to determine the interaction time between the plectrum and the
string.

The Edge parameter is used to determine the sharpness of the edge of the pick. It is used to
fine-tune the profiles of the three different plectrum models which affects the shape of the force
signal exerted by the plectrum on the string and therefore the tone of the resulting sound. Turning
this knob clockwise results in a rounder edge and a softer sound while turning it clockwise makes
it sharper with more high frequencies in the tone. Finally, the Position knob is used to control the
position of the interaction point of the plectrum along the string. This is a parameter currently used
by guitar players to change the tone of the sound. In its leftmost position, the pick is very close to
the bridge resulting in a more metallic sound. Turning the knob clockwise moves the pick toward
the fretboard resulting in a rounder sound.



60 Parameters

6.6.3 The Hammer Module

The Hammer module is used to control hammer-on et pull-off effects as explained
in section 6.2.3. In Strum, hammer-ons and pull-offs are triggered when legato playing
on the keyboard is detected. The three parameters of this section are Tone, Amp and
Velocity. The Tone knob is used to set the harmonic content of the excitation produced
by the finger moving on the string as explained above. Turning this knob to the left
results in a smoother sound while turning it clockwise results in a sharper sound. The
Amp parameter controls the amplitude of the excitation generated by hammer-ons and
pull-offs.

6.6.4 The Mute Module

In Strum, strings are muted when using the muffled downstroke or upstroke
strumming keys or, in auto-strum mode, when a note is released on the key-
board. This reproduces the muting effect obtained by guitarists by releasing the
pressure on the notes held by the fretting hand. The pressure applied on a given
string is controlled using the Contact knob. In its leftmost position, the contact
is very light and one can slightly hear the sound of the open string. When this
knob is in its rightmost position, the pressure between the finger and the string is
strong and one can hear the pitch of the fretted note. In its middle position, the
string is muted efficiently and one can, depending on the fret where the finger
is located, hear harmonics ringing. The tone and decay time of these harmonics
are set using the Tone and Decay knobs which fix the decay time and the spectral content of these
tones respectively. When muting a string it takes a little time for the guitar player to release the
pressure on the finger on the string in order to place them in muting position. This time is set using
the Time knob and the release time is increased by turning the knob clockwise.

6.6.5 The Palm Module

In Strum, palm muting is achieved by using the palm muted downstroke and up-
stroke keys. The resulting sound of this effect can be adjusted with the help of the
Decay and Tone parameter. The Decay knob is used to set the decay time of the sound
when the strings are palm muted. In other words, it controls the amount of overall damp-
ing induced by the picking hand. Turning this knob clockwise increases the decay time.
The Tone knob controls the amount of high frequencies in the resulting sound relatively
to the amount of low frequencies or in other words the tone of the sound. Turning this
knob clockwise increases the amount of high frequencies in the sound.
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6.6.6 The Body Module

The Body module simulates vibrations of the top plate of the body of the
guitar, or soundboard, and that of the air cavity of the body. The soundboard of
the body is efficient at radiating a large range of frequencies while the role of
the air cavity is to boost low frequencies. A Tone knob is provided for the plate
while a Decay knob is provided for both the plate and air cavity of the body.
The Tone parameter is used to control the decay time of high frequencies with
respect to that of low frequencies. This takes into account the fact that depend-
ing on the material, the decay time varies for different frequency components
of the sound. In its leftmost position, the decay time of high frequencies in
the sound is lower than that of low frequencies; in its rightmost position it is
longer. The overall decay time of the both the air cavity and plate vibrations is controlled with the
help of the two Decay knobs and it is increased by turning the knobs clockwise.

The Size selector knob allows one to control the size of the body. Basically, reducing the size
of the body, shifts its frequency response toward higher frequencies while increasing it, results in a
shift toward lower frequencies. Available sizes are very large(xl), large (l), medium (m), small (s)
and very small (xs).

6.7 Performance Parameters

6.7.1 Chord Display

The Chord Display is where Strum displays the name of the detected
chord or note and the corresponding voicing selected. Strings are labeled
from lowest to highest as follows:

• String 6: E2 (MIDI note number 40)

• String 5: A2 (MIDI note number 45)

• String 4: D3 (MIDI note number 50)

• String 3: G3 (MIDI note number 55)

• String 2: B3 (MIDI note number 59)

• String 1: E4 (MIDI note number 64)

Notes played are identified by a circle on the corresponding string and the position on the
fretboard is determined by the fret number appearing in the upper left corner of the display which
corresponds to the number of the first fret in the display. Strings that are not played are marked
with an ’X’ at the top of the chord display. When a string is triggered, its number is highlighted
at the bottom of the display while it vibrates. For a list of all the chords detected by Strum, please
refer to section 11.
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Additional information on the chord is available at the top of the display above the name of the
chord itself. When the chord detected contains no third or no fifth the corresponding no 3 or no 5
message is highlighted. Finally, while Strum can recognize a great variety of chords and find most
voicings used by guitar players, it is possible that it will not find a voicing in its chord database for
a particular chord played on the keyboard. In these cases, the no match message is lit. Strum will
still display the chord name and propose a guitar voicing constructed according to a certain set of
rules. The chord should still sound right but the message is displayed in order to indicate that the
voicing chosen by Strum is probably very difficult to play on the guitar and might therefore not be
commonly used by guitar players.

6.7.2 Chord

On the guitar, chords can be voiced in many different
ways. The specific voicing chosen by Strum for a chord de-
pends on the Type parameter. One can choose between open,
movable and drop chords as described in section 4.6. The
voicing can also be made more precise by specifying what
should be the lowest note of the chord played by Strum. In
root position, the lowest note of the guitar voicing is always the root of the chord played on the
keyboard and detected by Strum. In lowest position, the lowest note of the voicing follows the
lowest note played on the keyboard. It is also possible to tell Strum in which neck position to play
chords using the Playing Position parameter. The position is specified in fret number and indicates
the lowest fret on which the lowest note of the chord should be played. It is not always possible to
satisfy this constraint and Strum will respect this position whenever it is possible. This parameter
is of course only valid for movable chords and it is therefore inactive when open chords are chosen.

The last parameter in the Chords section is called Time. This parameter is used to control the
delay between the moment a chord is played on the keyboard and the moment it is triggered by
Strum. This parameter is necessary because when a chord is played on the keyboard, the notes are
not necessarily played simultaneously. Strum must therefore wait a certain time before sending a
group of notes to the chord detection module in order to make sure that it has received all the notes
which are supposed to form the chord. This delay should not be smaller than the interval between
the moment the first and last notes are played. Using a value too small for this parameter will result
in individual notes of the chord being played before is is actually strummed. The value of this
parameter should vary depending on the playing skill and style of the keyboard player and should
be adjusted to a value allowing enough time for a chord to be played on the keyboard and be well
detected by Strum.

6.7.3 Loop

The loop player is used to control Strum with MIDI loops. Loops can contain both chords and
strumming key sequences. In this case, playing a loop is similar to playing a tune. Loops can also
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only contain strumming sequences and the loop player is then used to play rhythmic or strumming
patterns over chords currently played on the keyboard. Using loops is useful to carefully control or
edit a performance or execute passages that are difficult to play on the keyboard.

Loops are loaded using the Load button of the player. This
will open a folder from which loops can be selected. If a loop
was already loaded in the player, the Load button will open the
folder where this loop is located. If the player is empty, this
button will open a default loop folder which can be specified
in the Preferences dialog from the Edit menu of the application. Loops can also be loaded by
clicking on them and drag-and-dropping them onto the MIDI loop player.

Once a loop is loaded, its name is displayed in the top part of the loop player. Information on
the tempo and time signature of the loop is displayed just below its name. The loop is started by
clicking on the Play button located in the lower part of the player. Once a loop has been started,
it can be stopped by clicking on the Pause button and then restarted again by clicking on the Play
button. While a loop is being played, indication on the current position within the loop is displayed
on the right of the middle section of the player. The position is indicated, from left to right, as
the current bar number and current beat within this bar. When a loop is loaded in the player, it is
possible to scan the loops in the same folder using the skip forward and skip backward buttons.
The loops are scanned in alphabetical order starting from the currently loaded loop.

Once a loop has been selected, it might be necessary to modify it. A loop can rapidly be
exported to the MIDI track of a sequencer by using the Drag MIDI button. To export the loop,
click on the Drag MIDI button, then drag-and-drop the file onto a MIDI track of a sequencer.

Strum is supplied with a library of MIDI loops which you can use to easily start creating a new
piece. The factory setting for the default MIDI loop folder is the folder where the library was first
copied when Strum was installed.

6.7.4 Strumming

The Strumming section includes parameters which are used to determine how
the strumming is performed. The Speed parameter controls how rapidly the dif-
ferent strings are played when a strum is triggered. The speed of the strum is
increased by turning the knob clockwise. This parameter can be modulated by the
keyboard velocity using the Velocity knob. When in its center position, the speed
is always that corresponding to the value of the Speed knob. Turning the velocity
knob clockwise increases the strumming speed for high keyboard velocities while
it reduces the speed for low keyboard velocities. Turning this knob below its mid-
dle position has the opposite effect; playing softly on the keyboard will increase
the strumming speed while playing hard will reduce the speed.

The Auto button is used to switch on or off the Auto-Strum mode. When this mode is on, notes
and chords will played by Strum as they are played on the keyboard. When Auto-Strum mode is
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off, chords are recognized and voiced by Strum but the strings are not triggered until strumming
keys are used. For more details on how to use the strumming keys, please refer to section 3.2. Note
that, as was mentioned in section 6.7.2, when the Auto-Strum mode is on, Strum introduces a delay
between the time notes are played on the keyboard and a the time a chord is actually triggered.
This delay is adjusted using the Time knob from the Chord section and is necessary in order to take
into account that notes in a chord are not necessarily played perfectly simultaneously.

The Range parameter located below the chord display is used to determine the range of strings
which will be played when an main strum and alternate strum is triggered. As was discussed in
section 4.4.4, it is indeed possible to define two strum ranges which can be used alternatively in
order to vary the tone color of the chords played. The main range is always used by Strum except
if the alternate strum strumming key (B4) is depressed while another strumming key is used or if
the hold pedal (with alt strumming position selected) is activated.

The range of the main and alternate strums can be adjusted by using the Main and Alt controls
located below the chord display. For each range the lowest and highest strings played when trig-
gering a chord are specified by click-dragging the cursors located at each extremities of the display.
Note that the range must contain at least one string.

6.7.5 Tuning

The Tuning module is used to transpose the output pitch of Strum. The output pitch
can be increased or decreased by one semi-tone by moving the tuning knob clockwise
or anti-clockwise respectively. When in its center position, Strum uses standard tuning
(A4 - 440 Hz).

The output can also be transposed by one octave by switching on the Octave button.
This is useful for reaching notes on the fretboard above C5 (MIDI note number 72)
where the special strumming keyswitches are located.

6.7.6 Pitch Wheel

The keyboard pitch wheel is used to perform bends or slides. A bend is an in-
crease of pitch obtained by pressing a string down on a fret and pushing the string up
or down after triggering the string with the fretting hand. It is usually limited to one
or two semi-tones. A slide is another technique used by guitar players to change the
pitch of a note. It is obtained by pressing a string down with a finger, triggering the
string with the fretting hand, and then moving the fretting finger up or down along
the axis of the neck of the guitar across a certain number of frets.

To choose between a bend or slide effect, click on the corresponding button of the pitch wheel
section. The range of the effect is selected from the Range drop-down menu. Note that a bend will
be applied on the last note played in a chord while a slide will be applied to all the notes forming
the chord.
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6.7.7 Aftertouch

In addition to the pitch wheel, monophonic aftertouch (channel pressure) can be
used to control a bending effect. The depth of the effect is controlled using the Depth
knob from the Aft. Touch section. In its center position, the depth is equal to 1 semi-
tone.

6.7.8 Hold Pedal

The hold pedal MIDI controller can have two functions in Strum. When the
Hold Chord button is switched on, Strum will hold the notes of a chord after the
keys on the keyboard have been released as long as the pedal is depressed or until
another chord is played. When the Alt. Strum button is switched on, the pedal can
be used to switch between the main and alternate Strum as described in section 4.4.4.

6.7.9 Mod Wheel

The modulation wheel is used to control vibrato. The speed and depth of the
vibrato is controlled by the Speed and Depth parameters respectively.
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7 Toolbar

The toolbar at the top of the Strum Acoustic interface allows you to monitor important
information related to your current set-up.

7.1 Program Display

Located on the left of the toolbar, displays the number and name of the program cur-
rently loaded in the synthesis engine. The + and − buttons on the left of the program
number, or alternatively the + and − keys on the computer keyboard, are used to nav-
igate upwards and downwards in the program list. The complete list of 128 programs
can be viewed by using the H button located on the left of the program number. When the preset
associated with the current program is different from the version saved in the preset library, the
preset icon to the left of the buttons changes color in order to indicate that saving is necessary in
order not to lose the changes that have been applied.

7.2 MIDI map

In the center of the toolbar, displays the name of the currently opened MIDI map. For more
information on MIDI maps, please refer to Section 8.2.

7.3 CPU meter

On the right of the toolbar, displays the percentage of the total CPU resources currently used by
Strum Acoustic.

7.4 Value Display

Just before the CPU meter, displays the value of the currently selected control on the interface. The
values range from 0 to 127 for knobs and 0 or 1 for buttons depending on whether they are in their
on or off position. For some controls, the value is displayed in the appropriate units.
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8 Audio and MIDI Settings

This chapter explains how to select the audio and MIDI devices used by Strum Acoustic as well as
how to create and edit MIDI links and MIDI maps. When referring to commands that are different
on Windows and Mac OS systems, the commands are listed in the following order: Windows
command/Mac OS command.

8.1 Audio Settings

8.1.1 Selecting an Audio Device

To select the audio device used by Strum Acoustic:

• Go to the Audio menu and choose the Audio Settings options. A list of the audio devices
installed on your computer will appear in the Audio Configuration window.

• Click on the audio device you wish to use and click on the OK button.

8.1.2 Audio Control Panel

To launch the audio configuration panel, choose Audio Control Panel under the Audio menu. This
command allows you to select the bit depth sample rate (22.05, 44.1, 48, or 96 kHz) and buffer
size, which affects how quickly Strum Acoustic responds to the control information it receives.
The smaller the buffer size, the shorter the latency, and vice versa.

On Windows systems using ASIO drivers, this command opens the control panel provided
with the driver and the content of the dialog depends on the driver. Some sound cards also require
that you close all programs before making changes to the buffer size or sampling rate. If you
discover this is the case with your sound card, please refer to the manufacturer’s documentation
for details on configuring it for optimum performance. Most sound card manufacturers also update
their drivers regularly. It is strongly recommended that you visit your sound card manufacturer’s
website regularly to ensure you are using the most up to date drivers and support software.

On Mac OS systems, this command launches the Audio MIDI Setup configuration application.

8.2 MIDI Settings

8.2.1 Selecting a MIDI Device

To select the MIDI device used by Strum Acoustic:

• Go to the MIDI menu and choose the MIDI Settings option. A list of the MIDI devices
installed on your computer will appear in the MIDI Configuration window.

• Select the MIDI device you want to use and click on the OK button.
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8.2.2 Creating MIDI Links

Every control on the Strum Acoustic interface can be manipulated by an external MIDI controller.
In most cases this is much more convenient than using the mouse, especially if you want to move
many controllers at once. For example, you can map the motion of a knob on the interface to a
real knob on a knob box or to the modulation wheel from your keyboard. As you use the specified
MIDI controllers, you will see the controls move on the Strum Acoustic interface just as if you had
used the mouse.

To assign a MIDI link to a controller:

• On the interface, right-click/Control-click on a control (knob, button), a contextual menu
appears. Select Learn MIDI Link.

• Move a knob or slider on your MIDI controller (this can be a keyboard, a knob box, or
any device that sends MIDI). This will link the control of the Strum Acoustic to the MIDI
controller you just moved.

MIDI links can also be created by right-clicking/Control-clicking on a control and choosing
the Add MIDI Link command which will open the Add MIDI Link window.

8.2.3 Editing MIDI Links

MIDI links can be edited in the MIDI Links window, which lists all the currently available MIDI
links.

• To edit the MIDI link, right-click/Control-click again on the control and choose Edit MIDI
Link to open the MIDI links window. You can also use the Edit MIDI Link command from
the MIDI menu.

• Click on the MIDI link you wish to modify and then on the Edit button to launch the EDIT
MIDI Link window.

• Specify the MIDI controller number and MIDI channel of the physical controller you wish
to link to the parameter in the corresponding drop-down menus.

• You can also adjust the Minimum Value and Maximum Value of the controller, which
are used to limit the range of MIDI controllers. The Minimum Value slider is used to
determine the position on the Strum Acoustic control which corresponds to the minimum
value sent by the MIDI controller; the Maximum Value slider determines the position which
corresponds to the maximum value sent by the MIDI controller. The leftmost position of
the slider corresponds to the Strum Acoustic control minimum position (left position for a
knob) while the rightmost position of the slider corresponds to the Strum Acoustic control
maximum position (right position for a knob).
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• Note that the range of a knob can be inverted by setting the value of Maximum Value to a
smaller value than that of Minimum Value.

• Click on the OK button and the link appears in the list of controllers linked to the control.

• Click on the OK button again to confirm the change and to leave the MIDI Links window.

• Note that the Minimum Value and Maximum Value of a MIDI link can also be set by
right/control clicking on the corresponding control and selecting the Set MIDI Link Mini-
mum Value or Set MIDI Link Maximum Value command. The value corresponding to the
control position will then be saved as the minimum or maximum value of the MIDI link.

8.2.4 Deleting MIDI Links

• To remove a MIDI link, right-click/Control-click again on the control and choose Forget
MIDI Link or choose the Forget MIDI Link command from the MIDI menu.

• MIDI links can also be removed from the MIDI Links window by clicking on the MIDI link
to be removed to select it, then by clicking on the Remove button and the OK button to
confirm the change.

8.2.5 Creating a MIDI Map

A set of MIDI links can be saved into a MIDI map by using the Save MIDI Link As from the
File menu. Different MIDI maps corresponding to different MIDI controllers can thereby be saved
for Strum Acoustic. A MIDI map can be loaded by double clicking on the corresponding MIDI
connector icon that appears in the browser when a MIDI map is saved. Furthermore a MIDI map
can be loaded automatically when an instrument is launched.

• To assign a default MIDI map, right-click/Control-click on the MIDI map icon and choose
the MIDI Link Info command. In the Edit Information Window, select the Set as default
MIDI Links option.

8.2.6 Empty MIDI Map

The factory MIDI maps include a MIDI map called No MIDI link. As its name suggest this map
is empty. Loading this map deactivates all the MIDI links.

It is possible to reload the original version of this MIDI map by importing the factory MIDI
maps file as explained in Section 5.9 in case it was modified by mistake.
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8.2.7 Defining a Default MIDI Map

It is possible to define a default MIDI map that will be loaded automatically when Strum Acoustic
is launched.

• First select a MIDI map by clicking on its icon in the browser and choose the MIDI Link
Info command from the Edit or the Ctrl-I/Apple-I keyboard shortcut. One can also right-
click/control-click on the MIDI map icon and choose the MIDI Link Info command.

• To change the default MIDI map select the Mark As Default option.

8.2.8 MIDI Program Changes

MIDI program changes can be used to switch between programs while playing. Strum Acoustic
will change the number of the current program used by the synthesis engine to the number corre-
sponding to the MIDI program change received by the application.

8.3 Latency Settings

The latency is the time delay between the moment you send a control signal to your computer (for
example when you hit a key on your MIDI keyboard) and the moment when you hear the effect.
Roughly, the latency will be equal to the duration of the buffers used by the application and the
sound card to play audio and MIDI. To calculate the total time required to play a buffer, just divide
the number of samples per buffer by the sampling frequency. For example, 256 samples played
at 48 kHz represent a time of 5.3 ms. Doubling the number of samples and keeping the sampling
frequency constant will double this time while changing the sampling frequency to 96 kHz and
keeping the buffer size constant will reduce the latency to 2.7 ms.

It is of course desirable to have as little latency as possible. Strum Acoustic however requires
a certain amount of time to be able to calculate sound samples in a continuous manner. This time
depends on the power of your computer, the preset played, the sampling rate, and the number of
voices of polyphony used. Note that it will literally take twice as much CPU power to process
audio at a sampling rate of 96 kHz as it would to process the same data at 48 kHz, simply because
you need to calculate twice as many samples in the same amount of time.

Depending on your machine you should choose, for a given sampling frequency, the smallest
buffer size that allows you to keep real-time for a reasonable number of voices of polyphony. To
adjust these parameters:

• Launch the Audio Control Panel
• Choose the sampling frequency and the audio format (16, 24, 32 bits)

• Adjust the buffer size

Note that this might not be possible on Mac OS or with ASIO drivers on Windows.
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9 Using Strum Acoustic as a Plug-In

Strum Acoustic is available in VST, AudioUnit and RTAS formats and integrates seamlessly into the
industry most popular multi-track recording and sequencing environments as a virtual instrument
plug-in. The plug-in versions will work exactly the same way as the standalone version, except
for the audio, MIDI, and latency configurations that will be taken care of by the host sequencer.
Furthermore Strum Acoustic works as any other plug-in in these environments so we recommend
that you refer to your sequencer documentation in case you have problems running Strum Acoustic
as a plug-in. We review here some general points to keep in mind when using a plug-in version of
Strum Acoustic.

9.1 Window Size

The size of the Strum Acoustic window is fixed when it is used as a plug-in.

9.2 Audio and MIDI Parameters

When Strum Acoustic is used as a plug-in, the audio and MIDI ports, sampling rate, buffer size,
and audio format are determined by the host sequencer.

9.3 Automation

Strum Acoustic supports automation functions of host sequencers. Automation can usually be done
by using MIDI links and recording MIDI events, or by recording the motion of controls on the
interface.

9.4 Multiple Instances

Multiple instances of Strum Acoustic can be launched simultaneously in a host sequencer.

9.5 Saving Projects

When saving a project in a host sequencer, the program list is saved with the project in order to
make sure that the instrument will be in the same state as when you saved the project when you
re-open it even if the preset library of the instrument was modified. MIDI links are also saved.

Note that the default program list (the same as that loaded in standalone mode) appears when
Strum Acoustic is opened in a new project or if a new instance of the plug-in is opened in an
existing project. To change the default program list, use the Save All Programs command from
the Programs menu in an instance of the instrument which displays the desired program list.
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9.6 MIDI Channel

Make sure that the MIDI controller, sequencer and Strum Acoustic all use the same MIDI channel.
If you are not certain of the channel used by your controller or sequencer, set the MIDI channel of
Strum Acoustic to Omni.

9.7 MIDI program change

MIDI program changes are supported in the plug-in versions of Strum Acoustic. When a MIDI
program change is received by the application, the current program used by the synthesis engine is
changed to that having the same number as that of the MIDI program change message.

9.8 Performance

Using a plug-in in a host sequencer requires CPU processing for both applications. The load on the
CPU is even higher when multiple instances of a plug-in or numerous different plug-ins are used.
To decrease CPU usage, remember that you can use the freeze of bounce to track functions of the
host sequencer in order to render to audio the part played by a plug-in instead of recalculating it
every time it is played.
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10 Quick Reference to Commands and Shortcuts

File Menu

Command Windows Mac OS Description

New Folder. . . Apple+Shift+N New Folder in the
Browser

Open Preset Ctrl+O Apple+Option+O Open the selected preset

Save Preset Ctrl+S Apple+S Save the current preset

Save Preset As. . . Save the current preset under
a new name

Save MIDI Links Ctrl+Shift+S Apple+Shift+S Save the current MIDI
links

Save MIDI Links As. . . Save the current MIDI links
under a new name

Import. . . Import a .strumA file

Export. . . Export a .strumA file

Restore Factory Library . . . Restore factory library and
programs. Everything else in
the browser is deleted.

Exit (Quit on Mac) Quit the application
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Edit Menu

Command Windows Mac OS Description

Undo Ctrl+Z Apple+Z Undo last command

Redo Ctrl+Y Apple+Shift+Z Redo last command

Copy Ctrl+C Apple+C Copy selected item

Paste Ctrl+V Apple+V Paste

Delete Del Delete selected item

Info. . . Ctrl-I Apple+I Edit information about a
selected item (browser)

Preferences Display the Edit General Preferences
window
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Audio

Command Windows Mac OS Description

Audio Settings Display the Audio Settings window

Audio Control Panel Display the Latency Settings window
if DirectSound is used, the ASIO
control panel when ASIO drivers are
used and the Audi MIDI setup
configuration tool on Mac OS systems
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MIDI

Command Windows Mac OS Description

MIDI Settings Display the MIDI Settings window

Learn MIDILink MIDI link learn mode for the
last control touched

Add MIDI Link Enables one to add a MIDI link on the
last controlled touched

Forget MIDILink Drop a MIDI link

Set MIDI Link
Minimum Value

Limit the value of a MIDI
link to a minimum value

Set MIDI Link
Maximum Value

Limit the value of a MIDI
link to a maximum value

Edit MIDIlinks Display the Edit MIDI links
window

All Notes Off Send an all note off signal
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Programs Menu

Command Windows Mac OS Description

Locate Program in Browser Ctrl-L Apple-L Locate the current program in the
browser and select it

Rename Program Ctrl-R Apple-R Rename the current program in the
program list

Switch to Program Ctrl-P Apple-P Change the current program

Save All Programs Save the entire program list including
modifications to programs. The list
will be in exactly the same state the
next time you open the application
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Help Menu

Command Windows Mac OS Description

About Srum Acoustic GS . . . Display the About Stum
Acoustic window

User Manual F1 Display the user manual

Quick Reference Sheet Display the keyboard layout
reference sheet

Authorize String Studio . . . Display the Authorization
window. Active only if the
application has not been
authorized.

Visit www.applied-acoustics.com . . . Launch the browser and go
to the AAS website.

Join the user forum . . . Launch the browser and go
to the AAS forum.

Get support . . . Launch the browser and go
to the support section of the
AAS website.
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11 Appendix - Lists of Chords Detected by Strum

We present here a list of the main chords recognized by Strum and for which it can find a guitar
voicing. The following guidelines should be kept in mind:

• The chords are presented using C as the root. They can be transposed in any key.

• For all chords, inversions are recognized except if they conflict with another chord from this
list.

• Inverted chords on the keyboard do not necessarily have a corresponding voicing on the
guitar. In these cases Strum will still propose a voicing; it is not guaranteed that this voicing
will be playable on the guitar and the no match sign will be lit in the chord display.

• When chords are played on the keyboard, the order of the notes above the root is not taken
into account by Strum. This implies that you can play the chords as you know them on the
keyboard without having to know or learn special voicings used by guitar players.

• Certain guitar voicings do not include all the notes played on the keyboard.

• In addition to the chords listed below, Strum can recognize other chords for which it has no
guitar voicing. In these cases Strum will still propose a voicing; it is not guaranteed that this
voicing will be playable on the guitar and the no match sign will be lit in the chord display.

List of Chords recognized and voiced by Strum

C Cm Csus2

Csus4 Caug Cdim

C([5) C6 Cm6

Cm6 (no 5) C7 C7 (no 3)

C7 (no 5) Cm7 Cm7 (no 5)

C7sus2 C7sus2 (no 5) C7sus4

C7sus4 (no 5) C7]5 Cdim7

C7[5 Cm7[5 CMaj7

CMaj7 (no 3) CMaj7 (no 5) CmMaj7

CMaj7sus2 CMaj7sus4 CMaj7[5
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List of Chords recognized and voiced by Strum

Cadd9 C9 C9 (no 5)

Cm9 Cm9 (no 5) C9sus4

C9sus4 (no 5) C9]5 C9[5

CMaj9 CMaj9 (no 5) CmMaj9

CmMaj9 (no 5) CMaj9[5 C6 9

Cm6 9 Cm6 9 (no 5) Cm11

Cm11 (no 5) C13 C13 (no 5)

Cm13 Cm13 (no 5) C13[9

C13[9 (no 5) CMaj13 CMaj13 (no 5)

C7[9 C7[9 (no 5) C7]9

C7]9 (no 5) C7[5[9 C7[5]9

C7]5[9 C7]5]9 C7]11

Cm7 11 Cm7 11 (no 5) CMaj7]11

C7[9]11 C7]9]11 C7]9]11 (no 3)

C7 13 C7 13 (no 5) Cm7 13

Cm7 13 (no 5) C7[13 CMaj7 13

CMaj7 13 (no 5) C7[9[13 C7]9[13

C9]11 CMaj9]11 C9[13
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List of Chords - Example of a possible position on the keyboard.

C Cm Csus2

Csus4 Caug Cdim

C([5) C6 Cm6

Cm6 (no 5) C7 C7 (no 3)

C7 (no 5) Cm7 Cm7 (no 5)

C7sus2 C7sus2 (no 5) C7sus4
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List of Chords - Example of a possible position on the keyboard.

C7sus4 (no 5) C7]5 Cdim7

C7[5 Cm7[5 CMaj7

CMaj7 (no 3) CMaj7 (no 5) CmMaj7

CMaj7sus2 CMaj7sus4 CMaj7[5

Cadd9 C9 C9 (no 5)

Cm9 Cm9 (no 5) C9sus4
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List of Chords - Example of a possible position on the keyboard.

C9sus4 (no 5) C9]5 C9[5

CMaj9 CMaj9 (no 5) CmMaj9

CmMaj9 (no 5) CMaj9[5 C6 9

Cm6 9 Cm6 9 (no 5) Cm11

Cm11 (no 5) C13 C13 (no 5)

Cm13 Cm13 (no 5) C13[9
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List of Chords - Example of a possible position on the keyboard.

C13[9 (no 5) CMaj13 CMaj13 (no 5)

C7[9 C7[9 (no 5) C7]9

C7]9 (no 5) C7[5[9 C7[5]9

C7]5[9 C7]5]9 C7]11

Cm7 11 Cm7 11 (no 5) CMaj7]11

C7[9]11 C7]9]11 C7]9]11 (no 3)
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List of Chords - Example of a possible position on the keyboard.

C7 13 C7 13 (no 5) Cm7 13

Cm7 13 (no 5) C7[13 CMaj7 13

CMaj7 13 (no 5) C7[9[13 C7]9[13

C9]11 CMaj9]11 C9[13
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12 License Agreement

IMPORTANT! CAREFULLY READ ALL THE TERMS AND CONDITIONS OF THIS AGREE-
MENT BEFORE OPENING THIS PACKAGE. OPENING THIS PACKAGE INDICATES YOUR
ACCEPTANCE OF THESE TERMS AND CONDITIONS. IF YOU DO NOT AGREE WITH
THE TERMS AND CONDITIONS OF THIS AGREEMENT, PROMPTLY RETURN THE UN-
OPENED PACKAGE AND ALL COMPONENTS THERETO TO THE PARTY FROM WHOM
IT WAS ACQUIRED, FOR A FULL REFUND OF ANY CONSIDERATION PAID.

This software program, any printed materials, any on-line or electronic documentation, and any
and all copies of such software program and materials (the “Software”) are the copyrighted work
of Applied Acoustics Systems DVM Inc. (“AAS”), its subsidiaries, licensors and/or its suppliers.

1. LICENSE TO USE. The Licensee is granted a personal, non-exclusive and non-transferable
license to install and to use one copy of the Software on a single computer solely for the
personal use of the Licensee. Use of the Software is subject to this Agreement.

2. RESTRICTIONS ON USE. The Licensee may not nor permit third parties to (i) make copies
of any portion of the Software, other than as expressly permitted under this Agreement; (ii)
modify, translate, disassemble, decompile, reverse engineer or create derivative and/or com-
petitive products based on any portion of the Software; (iii) provide use of the Software in a
network, timesharing, interactive cable television, multiple CPU service bureau or multiple
user arrangement to users not individually licensed by AAS, other than as expressly permit-
ted by the terms of this license. The Software is licensed to you as a single product. Its
component parts may not be separated for use on more than one computer.

3. OWNERSHIP. AAS retains title to the Software, including but not limited to any titles,
computer code, themes, objects dialog concepts, artwork, animations, sounds, audio effects,
methods of operation, moral rights, any related documentation and “applets” incorporated
into the Software. AAS retains ownership of and title to all intellectual property rights in the
Software, underlying technology, related written materials, logos, names and other support
materials furnished either with the Software or as a result of this Agreement, including but
not limited to trade secrets, patents, trademarks and copyrights therein. Licensee shall not
remove or alter any copyright or other proprietary rights notices contained on or within the
Software and shall reproduce such notices on all copies thereof permitted under this Agree-
ment or associated documentation.

4. LIMITED WARRANTY. Except for the foregoing, THE SOFTWARE IS provided “AS IS”
without warranty or condition of any kind. AAS disclaims all warranties or conditions, writ-
ten or oral, statutory, express or implied, including but not limited to the implied warranties of
merchantable quality or fitness for a particular purpose, title and non-infringement of rights
of any other person. AAS does not warrant that THE SOFTWARE will meet the Licensee’s
requirements or that the operation of the software will be uninterrupted or ERROR-FREE.
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5. LIMITATION OF LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY APPLI-
CABLE LAW, IN NO EVENT WILL AAS BE LIABLE TO THE LICENSEE OR ANY
THIRD PARTY FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL
OR EXEMPLARY DAMAGES WHATSOEVER, INCLUDING BUT NOT LIMITED TO
LOSS OF REVENUE OR PROFIT, LOST OR DAMAGED DATA, BUSINESS INTER-
RUPTION OR ANY OTHER PECUNIARY LOSS WHETHER BASED IN CONTRACT,
TORT OR OTHER CAUSE OF ACTION, EVEN IF AAS HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES, EXCEPT IN RELATION TO GROSS NEGLIGENCE
OR WILFUL BREACH OF THIS AGREEMENT BY AAS. NO AAS AGENT, REPRE-
SENTATIVE OR DEALER IS AUTHORIZED TO EXTEND, MODIFY OR ADD TO THIS
WARRANTY ON BEHALF OF AAS. THE TOTAL LIABILITY OF AAS FOR DAM-
AGES, WHETHER IN CONTRACT OR TORT, UNDER OR RELATED IN ANY WAY TO
THIS AGREEMENT SHALL BE LIMITED TO THE LICENSE FEES ACTUALLY PAID
BY LICENSEE TO AAS, OR IF NO FEES WERE PAID, AAS’ LIST PRICE FOR THE
SOFTWARE COVERED BY THIS LICENSE. THE EXCLUSION OF IMPLIED WAR-
RANTIES AND/OR THE LIMITATION OF LIABILITY IS NOT PERMITTED IN SOME
JURISDICTIONS, AND SOME OR ALL OF THESE EXCLUSIONS MAY THEREFORE
NOT APPLY.

6. TERMINATION. This License also shall extend to the Software and any updates or new
releases thereof obtained by the Licensee, if any, subject to any changes to this License made
by AAS from time to time and provided to the Licensee, provided AAS is under a separate
obligation to provide to Licensee such updates or upgrades and Licensee continues to have a
valid license which is in effect at the time of receipt of each such update or new release. This
License shall remain in effect until terminated. The Licensee may terminate this Agreement
at any time, upon notification to AAS. This Agreement will terminate immediately without
notice from AAS if the Licensee fails to comply with any provision of this License. Any
such termination by AAS shall be in addition to and without prejudice to such rights and
remedies as may be available, including injunction and other equitable remedies. Upon
receipt of notice of termination from AAS, the Licensee must (a) immediately cease to use
the Software; (b) destroy all copies of the Software, as well as copies of all documentation,
specifications and magnetic media relating thereto in Licensee’s possession or control; and
(c) return all original versions of the Software and associated documentation. The provisions
of Sections 1, 3, and 5 shall survive the termination of this Agreement.

7. GOVERNING LAW. This Agreement shall be governed by and construed in accordance with
the laws of the Province of Quebec, without regard to the United Nations Convention On
Contracts for the International Sale of Goods and conflict of laws provisions, if applicable,
and the parties hereby irrevocably attorn to the jurisdiction of the courts of that province. Les
parties sont d’accord à ce que cette convention soit rédigée en langue anglaise. The parties
have agreed that this agreement be drafted in the English language.

8. SEVERABILITY. If any of the above provisions are held to be illegal, invalid or unenforce-
able, such provision shall be severed from this Agreement and this Agreement shall not be
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rendered inoperative but the remaining provisions shall continue in full force and effect.

9. ENTIRE AGREEMENT. This Agreement is the entire agreement between AAS and the
Licensee relating to the Software and: (i) supersedes all prior or contemporaneous oral or
written communications, proposals and representations with respect to its subject matter; and
(ii) prevails over any conflicting or additional terms of any quote, order, acknowledgement,
or similar communication between the parties during the term of this Agreement except as
otherwise expressly agreed by the parties. No modification to the Agreement will be binding,
unless in writing and signed by a duly authorized representative of each party.

10. NON-WAIVER. No delay or failure to take any action or exercise any rights under this
Agreement shall constitute a waiver or consent unless expressly waived or consented to in
writing by a duly authorized representative of AAS. A waiver of any event does not apply to
any other event, even if in relation to the same subject-matter.
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aftertouch, 26, 65
alternate strum, 24, 65
apply offset, 47
arp keys, 24, 28
arpeggios, 24, 31
ASIO drivers, 67
audio, 67

configuration, 16, 67
device, 67
format, 67

auto wah, 54
auto-strum, 20, 28, 63

bass and chords, 34
bend, 25, 26
body, 50, 61
browser, 16, 39

customizing, 44
hide, 43
resize, 43

buffer size, 67, 70
buttons

tweaking, 46

challenge key, 10, 11
chords

change, 29
change of pitch, 29
detection, 19
detection time, 62
display, 61
drop, 36
list, 79
lowest, 36
moveable, 36
open, 36
root, 36
type, 62
voicing, 36

chorus, 53

mono, 53
stereo, 53

commands, 73
community, 18
compare, 41
contact, 17

database
backup, 45
restoring, 45

default MIDI map, 70
delay, 52
digital delay, 52
display, 47
documenting presets, 43
downstroke, 23, 30
driver, 67
drop chords, 36

edit, 41
edit mode, 55

strings, 56
edition of parameters, 55
effect

notch filter, 54
wah wah, 54

equalizer, 50
export, 44

factory presets, 16, 45
fingers, 58
flanger, 53

mono, 53
stereo, 53

folder
copying, 42
creating, 42
deleting, 43
renaming, 43

forum, 18
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general parameters, 47
getting started, 15
global, 50

hammer-on, 30, 49, 60
help, 17
hold pedal, 65

import, 44
individual strings, 24
installation, 10

knobs, 46
tweaking, 46

latency, 67, 70
loop player, 62

MIDI, 67
device, 67
loop player, 62
settings, 67

MIDI configuration, 16
MIDI controller, 68
MIDI links, 17

creating, 68
deactivate, 69
editing, 68, 69
factory, 45
range, 68

MIDI loops
creating, 36
using, 35

MIDI map, 44, 66, 69
default, 44, 70
documenting, 44
empty, 69
preset, 44

MIDI program change, 17, 40, 70
modulation, 47
modulation wheel, 26, 65
module

bypassing, 47
modules, 46

moveable chords, 36
muffled downstroke, 31
muffled strokes, 24
muffled upstroke, 31
multi-effect

auto wah, 54
chorus, 53
delay, 52
flanger, 53
phaser, 53
vibrato, 53

mute, 49, 60
mute all, 24
muted strum, 33

no 3, 61
no 5, 61
no match, 61
notch filter, 54

octave, 64
offset, 47
open chords, 36
output stage, 51
overview, 19

palm, 50, 60
palm muted downstroke, 31
palm muted upstroke, 31
palm muting, 24
parameters, 46, 47
partial strumming, 33
performance, 9
performance parameters, 61
phaser, 53
pick, 58
pick/fingers, 49, 58
picking, 24
ping pong delay, 52
pitch bend, 25
pitch wheel, 64
plug-in, 17

audio parameters, 71
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automation, 71
MIDI channel, 72
MIDI parameters, 71
MIDI program change, 72
multiple instances, 71
performance, 72
saving projects, 71
window size, 71

polyphony, 10
power chords, 35
preset, 16, 39, 66

backup, 44
browser, 39
changing, 40
compare, 41
copying, 42
database, 44
deleting, 43
documenting, 43
edit, 41
editing, 41
exporting, 44
factory, 45
importing, 44
library, 16, 39, 42
locating, 43
moving, 42
name, 66
playing, 40
program, 39
renaming, 43
saving, 41

program, 39
saving, 42

program list, 16
pull-off, 30, 49, 60

range, 63
redo, 41
registration, 10, 11
response key, 11, 14
reverb, 55

sampling rate, 10, 67
scratch, 31
shortcuts, 73
signal flow, 19, 20
standalone mode, 15
stationary bend, 34
strings, 48, 56
strum down, 28
strum range, 63
strumming, 20, 63

auto, 63
keys, 63

strumming keys, 20, 23, 28, 30
sustain, 65
system requirements, 9

tape delay, 52
toolbar, 66
tremolo picking, 33
trills, 33
tuning, 64

undo, 41
unlocking, 10
upstroke, 23, 30
user library, 18

vibrato, 26, 53
voicing, 19

wah wah, 54
website, 18
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